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MC-1II™ WP Flow Analyzer

Section 1

Section 1—Introduction

The NuFlo™ MC-III™ WP Flow Analyzer (Figure 1.1) packs a full spectrum of gas and liquid measurement

functionality, high-speed performance, and log archive and retrieval capabilities in an easy-to-use
weatherproof totalizer. Commonly used operations can be accessed from the six-button keypad on the front
of the instrument or from the dynamic interface software, allowing you to calibrate and configure the unit

quickly and easily.

Operation

The MC-III WP calculates and displays instantaneous flow
rates and accumulated totals based on a turbine flowmeter
input signal. The MC-III’s microprocessor circuitry counts
the pulses generated by a companion flowmeter, converts
that data into volume and rate values in accordance with
calibration settings, and displays the totalized data on a
two-line liquid crystal display (LCD). The eight-digit top
readout indicates total flow volume; the six-digit bottom
readout indicates flow rate.

With the press of a single key, totals are saved to
nonvolatile memory, minimizing the risk of data loss even
if a power outage occurs.

Up to 384 daily logs, 768 hourly logs, and 345 event logs
can be archived and accessed quickly on demand.

Offering a variety of user-configurable display options,
input and output options, RS-485 Modbus® compatibility,
flow logging, and turbine flowmeter linearization, the
MC-III WP is one of the most versatile totalizers on the
market. For specifications, see Table 1.1, page 2.

[ — ] e | s | e——

7 NuFlo MC-Hil WP Flow Analyzer
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Figure 1.1—MC-IIl WP Flow Analyzer
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MC-1III™ WP Flow Analyzer

Table 1.1—MC-Ill WP Specifications

Hazardous Location
Certification

CSA-approved for US and Canada

Class I, Div. 2, Groups A, B, C, and D

Rated for Internal Pollution Degree 2

CSA/UL Type 4 Enclosure (Ingress Protection)
T5 Temperature Class

System Power

Internal power supply
+ 3.6 VDC, D-size lithium battery (2-year typical life)
« alkaline battery holder containing 3 D-size batteries

External power supply (6 to 30 VDC at 6 mA) with internal battery backup
(reverse polarity protected)

Loop-powered (4-20 mA) with internal battery backup
(reverse polarity protected)
Loop power: 8 to 30 VDC
Load resistance: 1100 ohms @ 30 VDC
200 ohms @ 12 VDC

Operating Temperature

Lithium-Powered: -40°C to 70°C (-40°F to 158°F)
Alkaline-Powered: -18°C to 55°C (0°F to 130°F)
LCD contrast is reduced below -20°C (-4°F)

Environmental

Humidity: 0 to 90% non-condensing
Altitude: Up to 2000 m, maximum

Enclosure

Molded fiberglass polyester, Lexan® polycarbonate viewing window
6.91 in. wide x 6.5 in. tall x 4.25 in. deep

LCD Display

8-digit Total (volume) display (7-segment characters)

6-digit Rate display (11-segment characters for easy-to-read prompts)

0.3” character height

Adjustable contrast and update period

User-selectable units of measurement (Total):
»  Preprogrammed units: BBL, GAL, LIT, M3, CF, SCF, any unit x 1000
*  User-defined units

User-selectable units of measurement (Rate):
*  Preprogrammed units: BBL, GAL, LIT, M3, CF, SCF (per DAY, HR,

MIN, SEC), any unit x 1000 (per DAY, HR, MIN, SEC)
» User-defined units

Keypad

6-key membrane switch

Communications/
Archive Retrieval

RS-485 Modbus® communications with transfer speeds up to 115.2K (allows
full download in less than 1 minute)

Logging

384 daily logs
768 hourly logs
345 event logs
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Table 1.1—MC-Ill WP Specifications

Inputs Turbine Meter Input
Configurable sensitivity adjustment via front panel
Sensitivity adjustment range: 20 mV P-P to 40 mV P-P
Frequency range: 0 to 3500 Hz
Remote Reset Input
Optically-isolated input
3.0to 30 VDC
Pulse duration > 3 seconds to reset
Pulse Input
Optically-isolated input
3.0to 30 VDC
Outputs Analog Output
4-20 mA, loop-powered (two-wire)
16-bit resolution
Accuracy: 0.1% of full scale @ 25°C, 50 PPM/°C temperature drift
Loop power: 8.0 to 30 VDC
Zero and full-scale engineering values configurable from front panel
RS-485 Communications
Baud rates: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 and up
to 115.2K
Volumetric Pulse Output
Solid-state relay
Output rating: 60 mA max. @ 30 VDC, on-state drop = 1.4 VDC @ 50 mA,
0.25VDC @ 10 mA
Configurable pulse width (duration): 10 to 60,000 ms
Amp & Square (Flowmeter Frequency) Output
Open-drain transistor output of turbine meter input signal
Output rating: 50 mA @ 30 VDC, on-state drop = 0.3 VDC @ 50 mA,
0.1VDC @ 10 mA
(Analog output and amp & square outputs cannot be used simultaneously.)
Modbus® RTU mode Modbus® supports 16-bit and 32-bit holding registers. For more

information, see Appendix C.

Enron Modbus®

Flow log parameters (time stamp, period total, period run time, and supply
voltage) and download method are Enron-compatible.

System Requirements

Operating System - Windows 2000 or later (Windows XP recommended)
Computer/Processor - 1 GHz or faster Pentium-compatible CPU
Memory - 128 MB of RAM

Hard Disk Space - 21 MB for program files, 30 MB for Adobe Reader,
adequate space for data files

Drive - CD-ROM for install

Display - 800 x 600 (SVGA), 16-bit (thousands of colors) color display or
greater

Browser - Internet Explorer 4 or later

Internet Connection - for web links, tech support

Communications Port - physical or virtual RS-232 compatible serial port
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WARNING EXPLOSION HAZARD—SUBSTITUTION OF COMPONENTS AND/OR THE USE OF EQUIP-
MENT IN A MANNER OTHER THAN THAT SPECIFIED BY CAMERON MAY IMPAIR SUIT-
ABILITY FOR CLASS |, DIVISION 2. CAMERON BEARS NO LEGAL RESPONSIBILITY FOR
THE PERFORMANCE OF A PRODUCT THAT HAS BEEN SERVICED OR REPAIRED WITH
PARTS THAT ARE NOT AUTHORIZED BY CAMERON.

DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN SWITCHED OFF OR
AREA IS KNOWN TO BE NON-HAZARDOUS.

DO NOT OPEN EQUIPMENT UNLESS SIGNAL CIRCUITS AND POWER HAVE BEEN
SWITCHED OFF OR AREA IS KNOWN TO BE NON-HAZARDOUS.

BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN TO BE NON-HAZARDOUS.

STATIC HAZARD. DO NOT CLEAN OR RUB ENCLOSURE UNLESS AREA IS KNOWN TO
BE NON-HAZARDOUS.

Key Product Features

This section presents an overview of key features of the MC-III WP. Many of these features are discussed in
more detail in Sections 3 and 4 (configuration procedures) and Section 5 (flow log archival).

Key features discussed here include:
* LCD display

» keypad

* interface software

* power supply

» calibration options

* input options

* output options

* flow log archival

» password-protected security

LCD Display

The liquid crystal display (Figure 1.2, page 5) provides a simultaneous indication of accumulated total (top
readout) and flow rate (bottom readout). The eight-digit total display uses 7-segment characters to form
numbers and letters, which results in a combination of uppercase and lowercase letters. The six-digit flow rate
display uses 11-segment characters to form numbers and letters for improved readability. When the keypad is
used to calibrate the MC-III WP, the name of the menu option selected appears in the lower (rate) display, and
settings are entered in the top (total) display.

Flow volume can be measured in barrels, gallons, liters, cubic meters, cubic feet, standard cubic feet or other
user-defined units. A multiplication factor is also available for indicating flow volume in terms of 1,000 units.
The unit of measure for the Total readout and the decimal point position are selected by the operator during
calibration. If a user-defined unit is used, none of the preprogrammed volume units will be visible on the
display during operation.

Flow rate can be measured in a wide variety of preprogrammed units, or other user-defined units. The flow
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rate unit of measure is selected in two steps: (1) a volume unit is chosen and (2) a time-base unit (per day, per
hour, per minute, or per second) is chosen. Users can choose any combination of preprogrammed volume and
time units in establishing the flow rate engineering unit (for example, gallons per hour, gallons per day, or
gallons per minute). Also, the volume unit used for the flow rate can be different from the volume unit used to
read Total volume. The unit of measure for the Rate readout and the decimal point position are selected by the
operator during calibration.

The daily index (Day) display is a two-digit number for selecting a daily archive log for viewing. The number
shown here represents the number of days that have passed since the log was saved. For example, an entry of
01 would yield yesterday’s log. An entry of 05 would yield the log generated 5 days ago. Up to 99 consecutive
daily logs can be viewed using the keypad. In addition, up to 384 daily logs, 768 hourly logs, and 345 event
logs can be viewed through the interface software.

The LCD contrast can be adjusted with the interface software (see Section 4).

Keypad

The six-button keypad allows users to perform a basic configuration of the instrument. Figure 1.3, page

6, summarizes the functions that can be accessed with each button. Most parameters can be configured in
seconds by selecting one of the three menu keys (K-Factor, Output, or Display), navigating settings with the
arrow buttons, and saving the selections with the Enter key.

Section 3 contains procedures for configuring the MC-III WP using the keypad. Icons of the six buttons
provide a pictorial reference to help guide users through each step of configuration.

Important: Some configuration parameters are accessible only through the interface software. See
Section 4 for instructions on configuring the instrument using the software.

S
guodoooo g -
(1) s

M’ ISEC

& 000000 g -

Figure 1.2—LCD display showing location of the Total, Rate, and daily index (Day) displays. Only the units of
measurement selected for displaying total and rate will be visible during normal operation.
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Enable/disable/set up 4-20 mA output
Enable/disable/set up pulse output

Enter slave address
Enter baud rate
Calibrate instrument Set engineering units/
Set flowmeter input sensitivity decimal placement
Select pulse input for Rate and Total readouts

LOG SAVE
During calibration, navigates During calibration, saves
between submenus and scrolls calibration settings
through menu selections
During operation, saves

During operation, accesses During calibration, Total to nonvolatile memory
daily volume archive incrementally changes

digits and decimal point Note: To zero the Total
Note: To zero the Total position, on/off settings readout, press the LOG
readout, press the LOG ] ] (left arrow) and SAVE (ENTER)
(left arrow) and SAVE (ENTER) ~ During operation, tests keys simultaneously.
keys simultaneously. temperature and system

voltage

Figure 1.3—MC-IIl WP keypad functions

Interface Software

Developed within the familiar Windows environment, the MC-III interface software is an intuitive and
easy-to-use application that provides access to all controls for setting up and operating the instrument. The
interface tailors the controls to the user’s needs, providing three options for configuring the instrument:

* a“Configuration Wizard,” which steps through the most common configuration tasks
» individual configuration menus for accessing specific settings
* an advanced menu that gives host programmers access to Modbus® registers

For instructions on installing the interface software and entering configuration parameters via the interface
software, see Section 4.

Power Supply

The MC-III WP is shipped with either a lithium battery or a battery holder containing three D-size alkaline
batteries. Alternately, the MC-III WP may be powered by an external power source; in this case, the lithium
battery or alkaline batteries provide a backup power supply, significantly extending battery service life.
Low-power microprocessor technology enables the MC-III WP to operate approximately 2 years on a single
lithium battery.

External Power Supply. The device will automatically switch to battery power when external power is
lost. The external power supply must be an approved ELV source, insulated from the AC main by double/
reinforced insulation per CSA C22.2 No. 61010-1-04 / UL61010-1 — 2nd Edition.

Wiring diagrams for connecting an external power supply are provided in Section 2.
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Multipoint Linearization
The MC-III interface software supports up to 12 calibration points in addition to single-point calibration based
on the K-factor provided with the turbine flowmeter. See K-Factor Type, page 61, for more information.

Gas Volume Correction

Gas turbine meters are calibrated in actual cubic feet (ACF), and measure gas in actual cubic feet. In some
applications, a user may benefit from referencing gas measurements back to standard conditions by measuring
in terms of standard cubic feet (SCF). The MC-III WP makes this process quick and easy, by using fixed
average values for the flowing gas temperature and flowing gas pressure. See Gas Volume Correction, page
63, for more information.

Input Options

The flowmeter signal can be obtained from a magnetic pickup or a pre-amplifier device. The sensitivity of
the flowmeter input may be adjusted with the instrument keypad or the interface software. See Section 2 for
wiring diagrams. See Sections 3 and 4 for configuration procedures.

Output Options
The MC-III WP standard circuitry provides:

» ascaled pulse output representing an increment in volume for each pulse

* aloop-powered 4-20 mA output representing the flow rate

* aflowmeter frequency output for use with remote equipment to derive flow rate and volume
» an RS-485 output for communication with interface software or other telemetry equipment

When the 4-20 mA rate output feature is used, the MC-III WP is powered by the current loop, and the lithium
battery or alkaline batteries are used as a backup supply.

The pulse output and 4-20 mA output features should be turned off when not required for reduced current
consumption. See Section 2 for wiring diagrams. See Sections 3 and 4 for configuration procedures.

Flow Log Archival

The MC-III WP saves up to 384 daily logs and 768 hourly logs in nonvolatile memory. By connecting with
the interface software, users can download the logs for viewing and/or printing in tabular format or in a trend
chart.

Users can also export daily and hourly logs to a spreadsheet. For more information, see Section 5.

Event Log Archival

The MC-III WP saves up to 345 user event logs. Event logs are generated to track user changes such as
K-factor changes, input setting changes, power-on reset and “watch-dog” reset, flow cut-off and frequency
cut-off.

By connecting with the interface software, users can download the logs for viewing and/or printing in tabular
format. In addition to showing old and new values, each event log is time-stamped, and includes the register
associated with the change. For more information, see Section 5.

Password-Protected Security
A keypad security access code prevents unauthorized personnel from altering the calibration or accumulated
volume data in the instrument. The security feature may be disabled if this protection is not required.
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Password-protected security access is enabled using the interface software. When this feature is enabled,
the user will be prompted for a password when attempting to enter any menu from the keypad. For more
information, see Security Setup, page 55.

Commonly Used Functions

While the functions of the MC-III WP are too numerous to mention, some of the most commonly used
functions are detailed in this section. They include:

* reading the rate and accumulated total

* saving totals to memory

* resetting the total

* viewing daily and hourly logs

» saving and uploading configuration files
* exporting log data to spreadsheet

* saving log data in a report

Reading Totals

Current totals can be viewed from the LCD on the front of the MC-III WP or from the interface software
(MC-III Main screen). The software calculates the flow total and updates the LCD display every 4 seconds, by
default. The user can adjust the calculation period with the interface software. See Calculation Period, page
60, for more information.

Saving Totals to Memory

Hourly and daily totals are automatically saved to nonvolatile memory. A user may also save an accumulated
total at any time by opening the enclosure and pressing ENTER (SAVE) on the keypad. In the event of a
power failure, the last saved total will be displayed on the LCD when power is restored.

Important: Always save the accumulated total before replacing batteries.

Resetting the Total

Totals can be reset to zero using the keypad, the interface software, or a pulse from an external device.

*  To reset the total with the keypad, press LEFT ARROW (LOG) and ENTER (SAVE) keys simultaneously.

* To reset the total with the interface software, double-click the MC-III icon on the computer desktop and
wait for the software to connect to the instrument; then select MC-III Main from the Device Autorun Op-
tions screen, and click on the “Reset Flow Total” button in the lower right corner of the Main screen.

Viewing Daily and Hourly Logs

Each day, as the user-defined contract hour passes, a daily flow total is saved to nonvolatile memory. Hourly
logs are also automatically saved. A total of 384 daily logs and 768 hourly logs are accessible for viewing and
exporting using the interface software. See Section 5 for details.

Up to 99 daily flow log totals can be viewed from the LCD. Hourly flow log totals are accessible only through
the interface software.
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To view daily flow totals from the LCD, perform the following steps:

1. Press the LEFT ARROW (LOG) key on the keypad. The words “Daily Volume Archive” will scroll across
the bottom of the LCD and the day index will display “01.” The daily flow total recorded at the last con-
tract hour will appear at the top of the LCD.

The index number represents the number of days previous to the current date. For example, yesterday’s
totals are read by entering an index of “01”; totals from two days previous are read by entering “02.”

2. Press UP ARROW (TEST) to increment the index (01, 02, 03...); press LEFT ARROW (LOG) to decre-
ment the index (01, 99, 98...).

3. Press Enter (Save) to exit the Daily Volume Archive menu. (After 2 minutes of inactivity, the Daily Vol-
ume Archive menu will time out and the total readout will be restored automatically.)

Saving and Uploading Configuration Files

The MC-III interface software allows users to save an unlimited number of configuration files to their
computer. In the event that a configuration setting gets changed unintentionally or a user simply wants to
restore the settings he used previously, the user can upload the configuration file and resume operation within
minutes. The upload function also allows a configuration file to be loaded quickly into multiple devices. The
default directory for saving configuration files is C:\NuFlo log data\MC-III. However, MC-III WP users can
specify a different location, if desired.

For complete information, see Saving and Uploading Configuration Files, page 71.

Exporting Log Data

Flow logs and event logs can be directly exported to an .xIs or .csv file. For complete information, see
Exporting Flow Logs, page 83, and Exporting Event Logs, page 86. The default directory for exported logs is
C:\NuFlo log data\MC-III. However, MC-III WP users can specify a different location, if desired.

Saving Log Data in a Report

Flow logs can be saved in a report format that can be loaded back into the software for viewing or printing at
a later time. For complete information, see Printing/Saving a Report, page 79. The default directory for log
reports is C:\NuFlo log data\MC-IIN<WELL NAME>. However, MC-III WP users can specify a different
location, if desired.
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Section 2—Installation

The MC-III™ WP is fully assembled at the time of shipment and ready for mounting to a flowmeter.
Instruments for direct-mount installation include an enclosure attached to a threaded mount (Figure 2.1, page
12). Remote-mount instruments come with mounting brackets and bolts for attaching the instrument to a
vertical or horizontal pipe.

The MC-III™ WP is CSA-approved for Class I, Div. 2, Groups A, B, C, and D for use in hazardous locations.

Important: Before installing the MC-III™ WP, read the Important Safety Information section on the
inside cover of this manual.

Preparation

Before attempting to install the MC-III WP, make sure the flowmeter and magnetic pickup are installed as
follows:

1. Install the turbine flowmeter in the flow line.

2. Lightly grease the threads on both ends of the magnetic pickup, taking care to keep grease off of the con-
nector contacts. If the connector is plastic, apply grease only to the end that threads into the meter.

3. Install the magnetic pickup in the flowmeter.

4. After the flowmeter and magnetic pickup are installed in the flow line, mount the MC-III WP flow ana-
lyzer as described below.

Direct-Mount Installation

To install the MC-III WP on a turbine flowmeter, perform the following steps. Dimensions are provided in
Figure 2.2, page 13.

1. Position the MC-III WP above the flowmeter.

2. Plug the MC-III WP cable connector into the magnetic pickup and hand-tighten the knurled nut on the
connector.

3. Screw the MC-III WP mount onto the flowmeter threads surrounding the magnetic pickup.

4. With the display facing the desired direction, tighten the two screws on either side of the mount to prevent
horizontal shifting.

With the display oriented vertically in the desired direction, tighten the two hex-head bolts on either side of
the top section of the mount to prevent vertical shifting.

1
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Figure 2.1—MC-IIl WP to flowmeter connection
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Figure 2.2—Typical mount dimensions in inches (millimeters) for direct-mount installation
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Remote-Mount Installation on Vertical Pipe

The remote-mount MC-III WP Flow Analyzer is assembled at the factory for mounting on a vertical pipe. To
install the MC-III WP on a vertical pipe, perform the following steps. Dimensions are provided in Figure 2.3.

1. Place the “U” bolts around the vertical pipe section and through the mounting plate.

2. Fasten the mounting plate with the lock washers and nuts supplied with the “U” bolts.
3. Install the signal cable through the rear cable connector at the bottom of the enclosure.
4

Route the cable to the flowmeter and install as shown in the flowmeter user manual.

]

f ) 10.32in.
— 47 WulFle MG WP Fow Analyzer (2621 mm)

[ - 9.52 in.

K-FACTOR | ouTPUT DISPLAY 24 1 b 8 m m)
] MENU MJNU MENU
fi
(Teet |

= RESE] TOTAL

D

{ & =
/f

&
e

3.251n. 4.38 in.
4> .
“(82.6 mm) ‘ (111.3 mm)
< 6.91in.
(175.5 mm)

Figure 2.3—Typical mount dimensions in inches (millimeters) for remote-mount installation on vertical pipe
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Remote-Mount Installation on Horizontal Pipe

The remote-mount MC-III WP Flow Analyzer is assembled at the factory for mounting on a vertical pipe.
To install the MC-III WP on a horizontal pipe, the brackets must be removed and reattached in a different
position. To make the adjustment, perform the following steps. Dimensions are provided in Figure 2.5, page

16.
1.

N vk

Place the enclosure on its face and remove the four screws securing the brackets. Remove the brackets
and set aside the eight spacer flat washers (two at each screw hole). Retain the screws and washers for
use in steps 2 and 3. Note the two sets of mounting holes in the bracket. The screws are positioned in the
holes nearest the center of the bracket (as appropriate for vertical mounting) when the instrument leaves
the factory (Figure 2.4).

Dry-fit the brackets with the mounting holes in the enclosure so that a bracket extends to the right and left
of the enclosure (as opposed to top and bottom). Using the washers that were removed in step 1, place
two washers inside each screw hole inset in the enclosure and position the brackets on top of the washers
so that the enclosure screw holes align with the outer holes of the bracket.

Insert the screws that were removed in step 1 in the outer holes of the bracket and tighten with a screw-
driver (Figure 2.4).

Place the “U” bolts around the horizontal pipe section and through the mounting plate.
Fasten the mounting plate with the lock washers and nuts supplied with the “U” bolts.
Install the signal cable through the rear cable connector at the bottom of the enclosure.

Route the cable to the flowmeter and install as shown in the flowmeter user manual.

Screws fit in inner holes Screws fit in outer holes
for vertical installation for horizontal installation
o

Figure 2.4—Conversion of brackets for mounting instrument to horizontal pipe
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Figure 2.5—Typical mount dimensions in inches (millimeters) for remote-mount installation on horizontal pipe
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Field Wiring Connections

All field wiring enters the MC-III WP through the bottom of the enclosure and connects to the circuit
assembly inside the enclosure door. Wiring is routed through up to three conduit hubs (one hub is provided
with the unit and two additional entrances are plugged but available for use with customer-supplied hubs). A
rear cord connector is used for the magnetic pickup from the turbine meter.

Hazardous Area Precautions

WARNING Do not attempt to install the battery or connect field wiring unless the area has been de-

f classified or is known to be non-hazardous.

Wiring Procedure

Caution: All field wiring must conform to the National Electric Code, NFPA 70, Article 501-4(b) for

installations within the United States or as specified in Section 18-156 of the Canadian
Electrical Code for installations within Canada. Local wiring ordinances may also apply.
All field wiring must have a wire range of 22 to 14 AWG and terminal block screws must
be tightened to a minimum torque of 5 to 7 in-lbs. to secure the wiring within the terminal
block. Only personnel who are experienced with field wiring should perform these proce-
dures.

The instrument must be grounded with a protective earth grounding conductor in accor-
dance with national and local electrical codes. See step 3 of the wiring procedure below.

To wire the MC-III WP for operation, complete the following field connections:

1.
2.
3.

Unlatch the door of the enclosure to access the circuit assembly mounted inside the door.
Connect the lithium battery or alkaline battery holder to the J1 connector on the circuit assembly.

Connect a ground wire to the internal ground connection screw located inside the enclosure. The screw
is identified with the ground symbol, as shown in Figure 2.6, page 18. For DC-powered installations,
route the protective earth grounding conductor into the enclosure with the incoming power conductors.

Connect wiring for external power, if appropriate. See Figure 2.7, page 19.
Connect the flowmeter or pulse input wiring to terminal block TB1. See Figure 2.8 and 2.9, page 20.

Connect wiring for the remote reset input to terminal block TB1, if appropriate. See Figure 2.10 and 2.11,
page 21.

Connect wiring for output signals, if appropriate. See Figure 2.12 through 2.17, pages page 22 through
page 25.

Recalibrate the MC-III WP (if necessary).

If external and internal power supplies were removed, reset the clock to ensure that the time stamps in the
log data are accurate. The clock is reset using the MC-III interface software. See Time/Date Synchroniza-
tion, page 54.

10. Replace the enclosure cover by threading it onto the enclosure in a clockwise direction.

17
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I Ground screw
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Figure 2.6—Ground connection screw (enclosure shown with door removed)
Power Supply Wiring

Internal Power Supply
The MC-III WP is shipped with either of two internal power supplies:

e a3.6-V lithium battery
» alkaline battery holder containing three D-size batteries

Low-power microprocessor technology enables the MC-III WP analyzer to operate approximately 2 years on
a single lithium battery. The lithium battery is strongly recommended for use in extreme temperatures (below
-20°C).

Users can power the instrument from an external power supply or a 4-20 mA current loop, and use the lithium
or alkaline battery as a backup power supply. The use of an alternate power source extends battery life and
helps ensure that timekeeping and volume accumulation will not be interrupted during a power failure.

External Power Supply

The MC-III WP can be connected to a remote power supply by a two-conductor cable (Figure 2.7, page
19). The power supply and cable must be capable of supplying 6 to 30 VDC @ 10 mA. This capability is
available only if the 4-20 mA rate output is not used.

External Power Supply. The device will automatically switch to battery power when external power is
lost. The external power supply must be an approved ELV source, insulated from the AC main by double/
reinforced insulation per CSA C22.2 No. 61010-1-04 / UL61010-1 — 2nd Edition.

18
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Important:

In all applications using an external DC power supply, a protective over-current device
rated at a 0.5A maximum (such as a circuit breaker or fuse) must be connected to the
positive supply line of the DC power supply in the safe area. A recommended protec-
tive device is a 0.5-A ceramic fuse, such as the Bussman GDS-500mA or the Littelfuse
216.500.

A disconnect switch must also be included in the safe area within easy reach of the oper-
ator, and clearly marked as the “disconnect” for the safe area external DC power supply.

Caution:

The instrument must be grounded with a protective earth grounding conductor in ac-
cordance with national and local electrical codes. To ground the instrument, connect a
ground wire to the internal ground connection screw located inside the enclosure (Figure
2.7). For DC-powered installations, route the protective earth grounding conductor into
the enclosure with the incoming power conductors.

Caution:

When using the amp & square output with the external power supply, make sure the
power supplies for both features share a common negative (-) terminal or that they are
totally isolated from each other, since both share a common negative (-) connection.

Lo } [ POWER
SUPPLY
—°— 6to 30

VvDC

TFM
1no
0z

INPUT
IAVIS

35INd  98¥SYH

GROUND SCREW

T8
@
@
@
@
@
@

+— +— + -
RESET PULSE

INPUT

1no
OO0

Figure 2.7—EXxternal power supply wiring
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Input Wiring

WARNING If installing the MC-lll WP in a hazardous area, do not attempt to install input wiring un-
f less the area has been declassified or is known to be non-hazardous.

Turbine Flowmeter (TFM) Input
The TFM input provides the turbine flowmeter input signal generated by a magnetic pickup, enabling the
MC-II WP to calculate and display instantaneous flow rates and accumulated totals.

@Q
S
extPOWeR N (D
e (D
o
ABS Y

For a list of recommended pickup
adapters, see the parts list on page

97.
TB1 %\
OrTE 1] * A | TURBINE
) MAGNETIC PICKUP
@)1 485 B
o|+==
@|Es —
EE

Vturbine max = 5.0 Vdc or peak

Voc=1.0 Vdc
Isc = 5.0 mA max
Ca =30 pF max
La=2 H max

Figure 2.8—Flowmeter input wiring

Pulse Input
The pulse input provides an optically isolated input in systems where a preamplifier is inserted between the
sensor and the MC-I1T WP.

BATTERY

o

TB1

Q| =

kL, 1L

ANGE *—

%) PULSE INPUT
3TO 30VDC

Q|Es o+

QIHEZ °

Figure 2.9—Pulse input wiring
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Remote Reset Input
The remote reset input allows the operator to reset the accumulated volume on the MC-III WP to zero without
opening the enclosure. This input is optically isolated. The input is shown connected in two ways, with a

power supply and switch in a remote location (Figure 2.10), and with a pulse generator in a remote location
(Figure 2.11).

The reset input or reset pulse must be active for 3 seconds to clear the total.

@Q
SD
extPoWerR (D
I N (D
PN

K

BATTERY

INPUT

RESE PULSE TFM

NPUT|

F+- +—

POWER SUPPLY

3t030VDC
_|_

Figure 2.10—Reset input wiring (switch/power supply)
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RESE]  PULSE  TFM
NPUT|  INPUT
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Figure 2.11—Reset input wiring (pulse)
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Output Wiring

WARNING If installing the MC-lll WP in a hazardous area, do not attempt to install output wiring un-
less the area has been declassified or is known to be non-hazardous.

The MC-III WP supports four outputs: pulse output, 4 to 20 mA output, flowmeter frequency (amp & square)
output, and RS-485 output. Wiring diagrams for each feature are provided below.

Pulse Output
The pulse output is a solid-state relay. Each pulse represents a user-defined volume. Because the circuit is
isolated, it can be used in conjunction with any other feature on the MC-III WP. A two-conductor cable from

the MC-III WP to the remote location is required. The maximum current rating of the pulse output circuit is
60 mA at 30 VDC.

For information on configuring the pulse output with the keypad, see page 36. For information on configuring
the pulse output with the interface software, see page 69.

sV
<D
EXTPOWER N (D
e (D
IR

* Resistor may be included in pulse readout
device. Size the resistor to limit the current

to 60 mA.
TB1 TB2
ol = o & @ *
ol+E s8)e
Leave this POWEREUPPLY
@|1g5 ez @ end of shield 5t0 50 VDC
@ 4+ 22 r<n§ | @ disconnected. -
2|15 ez} lo1
ol+Ee Sehle | ( )
+ LT
( ] PULSE READOUT
wale DEVICE

Figure 2.12—Pulse output wiring

Analog (4-20 mA) Rate Output

The 4-20 mA rate output provides a linear current output that represents flow rate. This output requires a two-
conductor cable connected to an 8 to 30 VDC power supply (voltage required is dependent on loop resistance)
and a current readout device located in the remote location. The 4-20 mA rate output current loop also
powers the MC-III WP. The internal battery (lithium or alkaline) provides a power supply backup to maintain
timekeeping accuracy and to continue accumulating volume in the event that the 4-20 mA current loop fails.

Figure 2.13, page 23, shows the minimum required voltage to power the instrument for a given loop
resistance. In addition, the mathematical relationship between loop voltage and load resistance is given. For
example, if a power supply voltage of 24 volts is available to power the current loop, the maximum load
resistance would be 800 ohms.

Caution: The 4-20 mA rate output and the flowmeter frequency output circuits are not isolated
from each other and cannot be used simultaneously. When the 4-20 mA output option is
used, do not connect external power to TB3.
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For information on configuring the 4-20 mA rate output with the keypad, see page 33. For information on
configuring the 4-20 mA rate output with the interface software, see page 65.
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Figure 2.13—4-20 mA rate output wiring

Flowmeter Frequency Output
The flowmeter frequency (amp & square) output provides an open drain transistor output at the turbine meter
frequency, which may be used to provide flow rate and/or total information to peripheral equipment. The

output requires a two-conductor cable from the MC-1II WP to the remote frequency readout device requiring

50 mA or less and a 5 to 30 VDC power supply (Figure 2.14, page 24).

Caution: The flowmeter frequency output and 4-20 mA rate output are not isolated from each other
and cannot be used simultaneously.
Caution: When using the flowmeter frequency output and powering the device from an

external power supply, make sure both power supplies share a common negative (-)

terminal or are totally isolated from each other.
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The flowmeter frequency output terminals on the MC-III WP circuit assembly are labeled A & S to represent
“amp & square” output.
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Figure 2.14—Flowmeter frequency (amp & square) output wiring

RS-485 Output

The RS-485 output is required for communication with the interface software. Wiring diagrams are provided
for a permanent connection (Figure 2.16), as well as for temporary laptop connections using an RS-485 to RS-
232 converter (Figure 2.16 and 2.17, page 25).
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Figure 2.15—RS-485 output (permanent connection)
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TFM
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TX+ TD(B)
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INPUT
ANVIS

INPUT
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e~

TD(A)

GND

SISISISISIoE,
- + -

RESET PULSE

-+ —+
SISISISININ

Part No. 101283116
RESET RS-232
SWITCH 9-PIN
CONNECTOR
J2

Figure 2.16—RS-485 output (connection to laptop with 9-pin converter)
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Figure 2.17—RS-485 output (connection to laptop with 25-pin converter)
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Section 3—Configuration and Operation via Keypad

Calibration of the MC-III™ WP is a simple matter of entering necessary parameters into the instrument.

The process for calibrating the MC-III WP depends on how the instrument will be used. The keypad can

be used to calibrate the MC-III WP for liquid or gas measurement using preprogrammed units, or for liquid
measurement using a calculated divisor. When preprogrammed units are used, the MC-II1 WP automatically
calculates the divisor for volume calculation and the rate multiplier for flow rate calculation, making
calibration quick and easy.

Important: For compensated gas measurement, or gas or liquid measurement requiring multipoint
(2- to 12-point) linearization, calibration must be performed with the software user inter-
face (see Section 4).

The following parameters can be configured using the six-button keypad on the front of the instrument:
» calibration factor and unit

* units of measurement for Total and Rate displays

* decimal position for Total and Rate displays

e input type and sensitivity level

*  4-20 mA output

* pulse output scale factor

* slave address

¢ Dbaud rate
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Entering a Calibration Factor

When the volume is to be expressed in barrels (BBL), gallons (GAL), liters (LIT), cubic meters (M?), or cubic
feet (CF), and the flow rate is to be expressed in barrels, gallons, liters, cubic meters or cubic feet per day, per
hour, per minute, or per second, the MC-III WP calculates the divisor automatically; only the turbine meter
calibration factor is required.

When the volume is to be expressed in a unit other than the preprogrammed units listed above, a calculated
divisor must be entered at the K-Factor prompt. See Entering a Calculated Divisor, page 29.

To Enter a Calibration Factor:

Enter the K-Factor menu. Press K-FACTOR MENU.
-
ooo00000 -«
Select the unit of measure associated Press UP ARROW until the correct
with the calibration factor (typically, unit is displayed.

K-FBCTOR
00000000 -
K-FACTOR

pulses per gallon).

Enter the decimal point position for Press LEFT ARROW to select the
the calibration factor. decimal point.

N
3

Press UP ARROW to change the
position of the decimal point.

-
m
]
1

Press LEFT ARROW to save the
decimal point position and proceed
with entering a calibration factor.

Enter the calibration factor, starting Press UP ARROW until the last digit
with the last digit and entering digits of the calibration factor is displayed.
right to left.

L

r
[e]
[a]

A (pooooooo.
Press LEFT ARROW to select the ‘

next digit to the left. oG "_/'_ IEI,:”_-TG :{1

-

Repeat using UP and LEFT arrows to
enter all remaining digits.

Press ENTER. ENTER

SAVE

The Input Sensitivity menu will appear following the entry of the calibration factor. See Setting Input Type
and Sensitivity, page 30, for the input sensitivity configuration procedure.
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Entering a Calculated Divisor

When registering the volume in units other than cubic meters, cubic feet, barrels, gallons, or liters, a
calculated divisor must be entered in the K-Factor menu instead of the turbine meter calibration factor.

Important: When a calculated divisor is used, the units for both the volume display and the volume
portion of the flow rate display should be set to USER (no units visible on the display).

The divisor and divisor decimal point must be determined, then entered in the K-Factor menu.
The formula for calculating the divisor is:

Divisor = FC x CON

Where:

FC = meter factor in pulses per gallon (P/G)
CON = the conversion factor for number of gallons per unit volume of desired measure

To Enter a Calculated Divisor:

Enter the K-Factor menu. Press K-FACTOR MENU.
MENU
Select no unit of measure. Press UP ARROW until no unit is ‘
displayed (as shown). — 30000350

v —
-FACTOR
Enter the decimal point position for the Press LEFT ARROW to select the ‘

v
calculated divisor. decimal point. LOG UBDBGL-’DEI

Press UP ARROW to change the ‘
position of the decimal point. — v T
A-FRCTOR

Press LEFT ARROW to save the ‘
decimal point position and proceed
with entering a calculated divisor.

Enter the calculated divisor, starting Press UP ARROW until the last digit ‘

with the last digit and entering digits of the calculated divisor is displayed. N

right to left. = BHL,BBBBB
Press LEFT ARROW to select the ‘

next digit to the left. M v COrTro
AB-FACTOR
Repeat using UP and LEFT arrows to

enter all remaining digits.
Press ENTER.

ENTER
SAVE

The Input Sensitivity menu prompt will appear immediately following the entry of the calibration factor. See
Setting Input Type and Sensitivity, page 30, for the input sensitivity configuration procedure.
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Setting Input Type and Sensitivity

The flowmeter signal can be obtained from a magnetic pickup or a pre-amplifier device.

The input sensitivity of the MC-III WP is measured in millivolts (mV) peak-to-peak. This is the threshold
value at which the circuitry responds to a signal. If the input signal is less than this value, the MC-II1 WP will
not count the electrical pulses as a valid turbine meter signal. If the input signal is equal to or greater than this
value, the electrical pulses received at the input will be counted. Care must be taken to ensure that the input
sensitivity is high enough to reject any electrical noise on the signal line, but not so high that flowmeter pulses
are missed. The input sensitivity of the MC-III WP may be set to low, medium, or high when the input will be
provided by a turbine flowmeter.

If the input will be provided in the form of a pulse from a pre-amplifier or other device (rather than directly
from a turbine flowmeter), the “Pulse In” (pulse input) setting in the Input Sensitivity menu should be
selected.

See Section 2 for input wiring diagrams.

To Set Input Type and Sensitivity:

Enter the K-Factor menu. Press K-FACTOR MENU. e —
MENU

Locate the input sensitivity setting. Press ENTER, repeatedly if —

necessary, to bypass calibration

factor. “INPUT SENSITIVITY” will

scroll across the bottom display.
If the input is the turbine meter, select Press UP ARROW to select a ‘ Select low, medium,
a sensitivity setting: low, medium, or sensitivity setting. oL } __high, or Pulse In
high.

Press ENTER. "SAVING” will appear (g /_0
If the input is provided by a different in the bottom display.

device, such as a pre-amplifier, select

“Pulse in” (for pulse input). //\IPUI,— 5E
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Configuring the Total Display

The Total display can be configured for measuring volume in any of five preprogrammed units, any
preprogrammed unit times 1,000, or a user-defined unit.

Users can specify a decimal point position, ranging from 0.1 to 0.0001 of a unit.

To Configure the Total Display:

Enter the Display menu.

Press DISPLAY MENU. DISPLAY

MENU

Select the unit of measure in which
volume will be displayed.

Press UP ARROW until the correct
unit is displayed.

Note—If a calculated divisor was
entered, select user-defined (no units
visible).

-lit

-
m
1]
3

ooooooon =

To read the volume in terms of ‘ — — — - -
thousands of units (ex. 1.0 = 1,000 LH:]L,'BL’ULHJ 318
bbl), continue pressing UP ARROW X100
until both the unit of choice and the
X1000 option are displayed.

Enter the decimal point position. Press LEFT ARROW three times, ‘

or until the decimal point in the Total
display begins blinking.

Press UP ARROW to change the
position of the decimal point.

00000000 -

Press ENTER. "SAVING” will appear
in the bottom display.

ENTER
SAVE

Important:

Before enabling or disabling the “x 1000” unit option for displaying flow totals, clear the

total display to zero. If the total is not cleared, the accumulated total displayed will repre-
sent a combination of two different units and will not provide an accurate flow reading.
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Configuring the Rate Display

The Rate display comprises two parts: a volume unit and a time-base unit. The volume portion of the Rate
display can be configured in one of five preprogrammed engineering units or in a user-defined unit (for
use with a calculated divisor). To display the volume portion in multiples of 1,000 units, continue scrolling
through the volume unit options until the x1000 entry is displayed, along with the appropriate unit of
measure.

The time-base portion of the Rate display can be configured in one of four preprogrammed engineering units:
per day, per hour, per minute, or per second.

Users can specify a decimal point position, ranging from no decimal up to 0.001 of a unit.

To Configure the Rate Display:

Enter the Display menu. Press DISPLAY MENU. IR
MENU
Enter the volume factor used to Press LEFT ARROW. The volume ‘
express flow rate (Ex.: bbl in bbl/day). unit of measure in the bottom portion
of the LCD window should begin
blinking.

Press UP ARROW unlilthe desired 7% = 000000

volume unit of measure is displayed.
Note—If a calculated divisor was
entered, select user-defined (no units

TEST

visible).
Enter the time-base factor used to Press LEFT ARROW. The time-base ‘
express flow rate (Ex. /day in bbl/day). factor in the bottom portion of the

LOG

LCD window should begin blinking.
Press UP ARROW until the desired ‘

time-base factor is displayed. T GAL BGE’DBQ DAY

Enter the decimal point position. Press LEFT ARROW twice, or until ‘
the decimal point in the Rate display
begins blinking.

Press UP ARROW to change the ‘

position of the decimal point. _— At 300000 R
X

Press ENTER. "SAVING” will appear
in the bottom display.

LOG

ENTER
SAVE
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Configuring the 4-20 mA Rate Output

WARNING Do not make or break any connections on the 4-20 mA current loop unless the area is
f known to be non-hazardous.
Caution: Before performing any 4-20 mA configuration, ensure that all peripheral equipment con-

nected to the 4-20 mA current loop is either disconnected or disabled. Configuring and
testing the 4-20 mA output feature on the MC-IIl WP with the peripheral equipment in
operation may cause false alarms or erroneous operation of the peripheral device or as-

sociated equipment.

The MC-III WP has a 4-20 mA output feature that represents flow rate. Zero and full-scale values can be
configured to represent any flow rate range within the range of the flowmeter.

The low (or zero) setting is the flow rate value that will produce a 4-mA output. The high (or full-scale)
setting is the flow rate value that will produce a 20-mA output. Typically, the high value is greater than the

low value; this scenario is defined as “direct mode” in Figure 3.1.

Alternatively, users may configure the 4-mA and 20-mA outputs to have an inverse relationship, such that the
high value is less than the low value. This scenario is defined as “indirect mode” in Figure 3.1.

A

! ax 20 - Direct Mode
_ (High > Low)
<<

E

[72]

o

s

<

-

=

=

Fwnd F—— =
} } >
Low High
FLOW RATE
A

| 20— - — .

max 20 Indirect Mode
N (Low > High)
<

E

[72]

o

s

<

-

=

I min 4 - -

} }
High Low
FLOW RATE

Figure 3.1—Two options for configuring a 4-20 mA output
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See Section 2 for instructions on installing and wiring the 4-20 mA rate output.

Flow rates in-between the minimum and maximum rate setpoints will result in an output of current between
4 mA and 20 mA according to the following calculation:

_ [IMAX _IMIN]X

I =
°" High— Low

[RATE  zp — Low]+ 1,

Where:

I, = output current

I, ,x = maximum current output (20 mA)

I, = minimum current output (4 mA)

High = programmed flow rate that produces a 20-mA output

Low = programmed flow rate that produces a 4-mA output

RATE = flow rate

CURR
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To Configure the 4-20 mA Output:

Enter the Output menu.

Press OUTPUT MENU.

Enable or disable the 4-20 mA output.

Toggles between

Press UP ARROW to toggle output to ‘

“on” or “off’. 1L v “off” and “on”
[y

Press ENTER. If the 4-20 mA output (s oFfF

is enabled, the LCD will display the

“Low” flow rate and the decimal point
in the numeric display will begin
blinking.

4-20 mA

Enter the decimal point position for the
“Low” flow rate. The words “4-20 mA
LOW” should appear at the bottom of
the LCD.

Press UP ARROW to change the ‘

position of the decimal point. TEST BBL-,BBBGVB
Y-20 A LOW

Enter the “Low” (4-mA) flow rate.
Digits are entered from right to left.

Press LEFT ARROW until the
rightmost digit in the top display
begins blinking.

Press UP ARROW to change the
digit.

— — Y—
S (gooooooo
Y-20 mA LOW™

Press LEFT ARROW to select the
next digit to the left.

Continue pressing UP ARROW and
LEFT ARROW alternately to enter all
remaining digits.

Press ENTER. The LCD will display
the “High” flow rate and the decimal
point in the numeric display will begin
blinking.

ENTER

‘:ﬁ
<
m

Enter the decimal point position for the
“High” flow rate. The words “4-20 mA
HIGH” should appear at the bottom of
the LCD.

Press UP ARROW to change the ‘

position of the decimal point. TEST BEIQBBE’B'B
Y4-20 B HIGH"

Enter the “High” (20-mA) flow rate.
Digits are entered from right to left.

Press LEFT ARROW until the .
rightmost digit in the top display

Y—
begins blinking. = L-HJBBBDG&
Press UP ARROW to change the ‘

8420 WA HIGH™

Press LEFT ARROW to select the

next digit to the left.
Continue pressing UP ARROW and

LEFT ARROW alternately to enter all
remaining digits.

Press ENTER. —

The Pulse Output menu prompt will appear immediately following the entry of 4-20 mA parameters. See
Configuring the Pulse Output, page 36, for the pulse output configuration procedure.
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Configuring the Pulse Output

The pulse output feature of the MC-III WP is typically disabled to reduce current consumption. When the
pulse output is not needed, Cameron recommends that this feature be disabled.

If the pulse output feature is required, the user will be prompted to enter a pulse output scale factor, which is
the volume increment that will cause a pulse output to occur.

If the pulse output is configured via interface software instead of via the keypad Output menu, the user can
also specify a pulse length (pulse width), which determines the length of each output pulse in milliseconds
(ms). This parameter is configurable only with the interface software. See Section 4 for more information.

See Section 2 for instructions on installation and field wiring of the pulse output feature.

To Configure the Pulse Output:
Enter the Output menu. Press OUTPUT MENU.

OUTPUT
MENU

Locate the Pulse Output setting. Press ENTER repeatedly until the
words “Pulse Output” appear in the
lower display.

ENTER
SAVE

Toggles between
“off” and “on”

| f

Enable or disable the pulse output. Press UP ARROW to toggle output to
“on” or “off”.

-
m
]
1

Press ENTER. If the pulse output is — C’FF
enabled, the LCD will display “Pulse

SAVE
Output Scaler” and the decimal point -

in the numeric display will begin PULSE L’Lﬂ'
blinking.

Enter the decimal point position for the Press UP ARROW to change the ‘

output scale factor. position of the decimal point. TEeT E’DDE’BE’BQ GAl
..9SLALER

Enter the pulse output scale factor. Press LEFT ARROW until the ‘ Y—
Digit tered fi ight to left. ight t digit in the top displ N 1171 N
igits are entered from right to le gggirr:;os”ml(?rl]glln e top display S BL’BL’L’EH—,B L”
Press UP ARROW to change the ‘
digit ..5CALER

Press LEFT ARROW to select the ‘
next digit to the left. ha
Repeat using UP and LEFT arrows to

enter all remaining digits.

Press ENTER. —

SAVE

The Slave Address menu prompt will appear immediately following the entry of pulse output parameters. See
Entering the Slave Address, page 37, for information on entering the slave address.
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Entering the Slave Address

The slave address is a setting used in Modbus® communications. It is a number that ranges from 1 to 65535,
excluding 252 to 255 and 64764. If the Modbus® request message contains the matching address, the
device will respond to the request. In network arrangements, the device must have a unique slave address.
For more information about Modbus® communications, refer to the protocol manual section. If Modbus®
communications are not used, leave the slave address at the factory setting (1).

To Enter Slave Address:

Enter the Output menu. Press OUTPUT MENU. s
MENU
Locate the Slave Address setting. Press ENTER repeatedly until the —
words “Slave Address” appear in the 00800000

lower display.

The rightmost digit in the top display

will begin blinking. 5LHK’E HB, .n

Enter the Slave Address. Press UP ARROW until the correct ‘
(range: 1 to 65535, excluding 252 to digit is displayed.
255 and 64764)

TEST

Then press LEFT ARROW to select ‘
the next digit to the left.
Repeat using UP and LEFT arrows to

enter all remaining digits.

Press ENTER. o

The Baud Rate menu prompt will appear immediately following the entry of the slave address. See Entering
the Baud Rate below for the baud rate entry procedure.

Entering the Baud Rate

The baud rate is the number of bits per second that are on the serial port. This setting must match the setting
of the master device polling the MC-III WP or the serial port. This only applies to the Modbus® communica-
tions; if Modbus® communications are not used, leave the baud rate at the factory setting (9600).

To Enter the Baud Rate:

Enter the Output menu. Press OUTPUT MENU. ST
MENU
Locate the Baud Rate setting. Press ENTER repeatedly until the o - —
words “Baud Rate” appear in the f ;’b EL’B
lower display.
o iy g
bAUD RATE
Enter the baud rate. Press UP ARROW until the correct ‘

baud rate is displayed. Ty

Press ENTER. "SAVING” will appear
in the bottom display.

ENTER
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Section 4—Configuration and Operation via Software

The MC-III™ interface software provides easy access to all configuration parameters and is the quickest way
to configure the device. Instead of navigating keypad menus, users enter configuration parameters with their
computer keyboard.

While basic parameters can be configured with the keypad (see Section 3), the interface software is the
only means of accessing every configurable parameter. For example, multipoint calibration for liquid or
gas measurement and gas volume correction parameters for measuring gas in standard cubic feet must be
configured via the interface software.

Table 4.1, page 49, provides a quick reference for determining whether a configurable parameter is accessible
through both the keypad menu and the interface software, or only through the interface software.

Installing the Software

The MC-III interface software is stored on a CD that is shipped with each instrument, and it installs directly
onto a PC or laptop. To install the interface software on a computer, perform the following steps:

1. Place the MC-III CD in your CD-ROM drive.
2. The MC-III install screen will load automatically.
3. Click on “Next” to initiate the installation, and follow the instructions on the screen. An MC-III icon

(Figure 4.1) will appear on the desktop of the user’s PC or laptop when installation is complete.

To access the interface software, click on the MC-III icon on your desktop or go the Start menu and select
Programs>NuFlo>MC-I1[>MC-III.

MC-III

Figure 4.1—MC-III desktop icon

Accessing Help

The Help menu, accessible from the task bar at the top of the Welcome screen (Figure 4.2, page 40), provides
access to documentation designed to assist the user in installing, configuring, and operating the MC-I11 WP
flow analyzer. This documentation includes:

* a“read me” file for general reference (includes contact information for technical assistance)
» an electronic copy of the user manual
* an electronic copy of the quick-start guide for installing and configuring the MC-111 WP

* a COM troubleshooting guide for addressing communications errors (this guide will automatically display
on screen when a communication error is detected)

The manuals can also be downloaded from Cameron’s Measurement Systems Division website,
www.c-a-m.com/flo.
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Connecting to the Software

Important: Before attempting to load the interface software, verify that the MC-lIl WP is connected
to a computer with an RS-485 to RS-232 converter (see Optional Parts List, page 97). See
Section 2 for RS-485 output wiring diagrams (Figures 2.16 through 2.18, pages 24 and 25).

Once the software is installed, the program will automatically launch with the click of the NuFlo MC-III icon
on the desktop.

To connect to the MC-III software, perform the following steps:

1. Click on the NuFlo MC-III icon on the desktop, or select Start>Programs>NuFlo>MC-III>MC-III. The
Welcome screen (Figure 4.2) will appear and a Select COM Port window will prompt the user to select a
communications port be used for connecting with the MC-III WP (Figure 4.2).

2. Select a communications port from the dropdown list and click “OK.” The software will attempt to con-
nect with the MC-III WP (via an RS-485 to RS-232 converter). This automatic launch feature is referred
to as an “express connect.”

3. If'the internal time and date programmed into the instrument differs from the time and date displayed on
the computer by more than 60 seconds, the software will prompt the user to synchronize the instrument
time/date to match the computer time/date (Figure 4.3, page 41). This ensures that the instrument displays
correct time, regardless of time zone differences.

: File Options Help

Select from available serial ports:

COM1 i

OK Cancel

27 NuFlo

MC-IIl Flow Analyzer

Interface Software

8{12/2008 10:22:47 AM

Figure 4.2—Select COM Port window
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Confirm EJ

The device time differs frarm computer time by mare than 60 zeconds [125 sec].
Spnchronize to computer time now?

Figure 4.3—Prompt for authorizing time and date synchronization

The time difference setting used to generate a synchronize prompt is user-configurable. For more information,
see General Options, page A-1.

Automating Functions on Software Startup

When the software connects with the instrument, the Device Autorun Options screen appears (Figure 4.4).
From this screen, users can configure the instrument, download logs, or upload previously saved configuration
settings.

A checkbox at the bottom of the Device Autorun Options screen allows the user to bypass the Device Autorun
Options screen and perform a selected function each time the software connects to the instrument.

Example: To download all logs on connection, select Download all logs from the Device Autorun Options
screen and check the “Always do...” checkbox. Each time the software computer connects to the instrument,
the software will bypass the Device Autorun Options screen, open the Flow Archive screen, and download all
logs. See Section 5 for more information on flow logs.

Device Autorun Options

Wwhat do you want the program to do’?

, Launch the Configuration Wizard
Which weill step you though the basic settings of the instrument
[T Go to MC-Il Main

'ﬂ Where every feature of the MC-Il can be programmed

Go to Advanced Access
For advanced users to directly manipulste the MODBUS registers

ri’ Download all logs
b P Iy retrieve all log data (daily, hourly, and events)

r' Download only new logs
~ Automatically retrieve unread log data (daily, hourly, and events)

Upload a configuration
Taoinstall & previously saved device configuration

< |3

v | Always dothe selected action on connection

L Dol Moy J | Cancel

Figure 4.4—Device Autorun Options screen
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Changing Autorun Settings

To change an autorun setting —that is, to initiate an autorun action, to terminate an autorun action, or to
change to a different autorun action—without exiting to the Welcome screen, choose Options/Program
Options from the menu bar and select Autorun from the dropdown list (Figure 4.5).

,-Options n
Genersl Autorun Options

Communications
Dovevnloading
Achvanced

Avtorun Options
Launch the Configuration YWizard
= Goto MC-I Main
Goto Advanced Access
Davwvnload all logs
Dovwvnload only newy logs

Upload & configuration

| Always do the selected action on connection

| Ok | | Cancel

Figure 4.5—O0Options/Program Options screen for changing autorun settings

Express Connect Option

By default, the MC-III interface software automatically attempts to connect to the instrument when a user
clicks on the desktop application icon. For more information on disabling the “express connect” feature and
changing communications options, see Appendix A.

Canceling Express Connect

To temporarily cancel the “express connect” function without exiting the software program, click in the LCD
area of the device on the Welcome screen or choose File>Cancel Express Connect from the menu bar (Figure
4.6, page 43). The software will stop all attempts to connect to the device. The “express connect” function
will be restored when the user exits the program and attempts to re-open the software.
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By M- E]
3 options el

@ cancel Express Connect Shift+Ctri+C k |
@ Discover Modbus Slaves...  Shift+CtrD

=3 Connect Device At Address... Shift+Ctrl+a il
@j Ext Cukx

Irl T |‘ TH .
% L 7

\QMCMEXPHVWAMW

Z7 NuFlo
MC-IIl Flow Analyzer

Interface Software

[

MC-III detected - serial no. 4294967295 com1 v 1.3.0 8/12/2008 10:37:05 AM

Figure 4.6—Cancel Express Connect option

To reattempt a connection to the device after canceling the “express connect” function, click the LCD on the
Welcome screen again, or choose File>Express Connect from the menu bar.

Changing the Communications Port

The computer will attempt to connect to the MC-III WP via the port that the user selects the first time

he connects to the instrument. However, if a network dictates that the computer connect through another
communications port (actual or virtual), the user must specify the appropriate COM port. To change the COM
port setting, click on Options>Select COM Port (Figure 4.7), and select the appropriate COM port from the
list of ports detected.

B mc-1il X
Ee [ Help

B8 Select COMPort...  Shift+Ctri+M
l & Program Options...  Shift+Ctrl+O ’
@ ""E““"
n
e ITIN
WAL 1.

L
‘ \E.Mcmswrmnnm 4

Figure 4.7—COM port selection menu

Software Connection in Multi-Device Network

In most cases, the automatic launch (or “express connect”) feature is a convenient time-saver. However, if
multiple devices are daisy-chained together in a network, this feature can interfere with the user’s ability to
connect to a specific device. The software allows the user to temporarily disable the “express connect” feature
and query the system for all connected devices. From the resulting list of devices, the user can then connect to
the appropriate slave address.

To select a device from a network of instruments, perform the following:

1. From the Welcome screen, choose File>Cancel Express Connect (Figure 4.6).

43



Section 4

MC-III™ WP Flow Analyzer

Click File>Discover Modbus® Slaves.

Enter a range of addresses you want to search (Figure 4.8).

Adjust the time-out setting, if necessary.

Click “Search.” The software will scan all addresses specified and display all instruments connected.

2
3
4. Enter the baud rate established for network communications.
5
6
7

Click on the appropriate address to connect to a device.

Important: In daisy-chain configurations, verify that each device has a unique slave address.

Discover Modbus Slaves E|

Discover Modbus Slaves

5| BaudRate: [9800baud ¥

End Addr: 5 5| Timeout {ms): o0 3

Start Addr; 1

Double-click a discovered device to connect.

Addr 1: Serial Mo 300000, Product ID 64, Firmware 1,00
Addr 2 - Mo response
Addr 3 - Mo response

Addr 5 - Mo response

Close

Figure 4.8—Automatic detection of all connected devices

A user who knows the address of a specific device may also connect to it by clicking File>Connect Device at

Address (Figure 4.9).

Connect Device At

Slave Address: h = |
Baud Rate: 19600 baud = |
Timeout (ms): | 1000 O
Ok | | Caneel

Figure 4.9—Slave address selection screen
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Setting Log Download Preferences

The MC-III WP automatically saves daily flow logs on the contract hour, and hourly flow logs around the
clock. The instrument also automatically creates an event record each time a user change is made. After
downloading these logs from the instrument, the instrument saves the data in a file. By default, the logs are
saved as .csv files.

The file format of the auto-save flow log and event log files is user-configurable. Users can configure the
software to download the auto-save flow and event logs as Excel (.xIs) files by selecting Options>Program
Options>Downloading from the menu bar (Figure 4.10).

Program Options

;;;Dptions . -
Eerl Downloading Options

Aukarun
Cammunications

Auko-save log file type
Downloading — :
5% - Comma-separated values text file

Advanced
# ¥LS - M3 Excel file

|| Use quate character () as a delimiter in C5¥ file exports
Auktomatically mark new records as read after downloading

|v| Round Flow values ko number of decimal places set for Flaw Volure Display

oK | | Cancel

Figure 4.10—Log file type selection
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Configuring the MC-IIl WP

The MC-III WP offers three methods for configuring parameters:

e The “Configuration Wizard” (Figure 4.11) condenses the configuration process into nine easy-to-follow
steps (compensated gas measurement and multipoint linearization are not supported in the wizard).

*  The MC-III Main screen (Figure 4.12, page 47) gives users complete access to all configuration param-
eters.

» The Advanced screen (Figure 4.13, page 47) provides access to Modbus® registers that can be modified to
change configuration parameters (recommended only for system configurators and host programmers).

If the desired configuration settings have been saved previously, the configuration file can also be uploaded,
eliminating the need to re-input configuration data. See Saving and Uploading Configuration Files, page 71,
for details.

Device Autorun Options

wihat do pou want the program to do?

Configuration Wizard

Welcome to the MC-III Configuration
Wizard

Launch the Configuration Wizard
i ill step you though the ks i he instrumer

This wizard will guide you through the BASIC setup of the

T P— o
= | Go to MC-Ill Main NUFla MC-lll EXP and MC-Il WP Flow Analyzers

I ‘ﬂ wWhere every feature of the MC-Il can be programmed

Go to Advanced Access
For advanced uzers to directly manipulate the MODBLUE regisy
v Download all logs
bl ~utomaticaly retrieve all log data (daily, hourly, and events)
Q Download only new logs
Automatically retrieve unread log data (daily, hourly, and eve

Upload a configuration
Toinstall & previously saved device configuration

<

For access to ALL MC-lll features, click Cancel and disconnect
from the MC-Ill device. Then reconnect to the MC-IIl device and
choose "Go to MC-Ill Main" in the Device Autorun Options screen

To continue, click Mext.

Alvways daothe selected action on connection

[ Do it Moy J | Cancel

Figure 4.11—Configuration Wizard (for novice users)
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Device Autorun Options

wihat do pou want the program to do?

e View Options Help

Launch the Configuration Wizard
which will step vou though the basic settings of the instrumery

SYSTEM Instrument Settings Archive Status
3i Go to MC-lll Main e Contract Hour 8:00 AM Daily Logs 51 unread, 384 max
[vvhere every feature of the MC-ll can be programmed \/‘}f‘ K-Factor 900.00 pulses/gal Hourly Logs 767 unread, 768 max
5‘“ Calculation Period 4 seconds Events Logs 8 unread, 345 max
Go to Advanced Access Lart Flow Input Sensitivity  Low sensitivity
For advanced users to direct] i i ; U
y manipulate the MODBUS regist Gas Volume Correction  OFF
Supply Voltage 361V
(L9 Download all logs 420mADuput  OFF By Vokaguils a7
bl ~otomatically retrieve all log data (daily, hourly, and events) ot Tempersture 2 7:1 26, 80.8:F
é& Pulse Output OFF System Clack 08/16/08 09:56:47 AM
Download only new logs g = s
Automatically retrieve unread log data (daily, hourly, and even) Flow Readings |
) Flow Total 753.4 bbl | P i
Upload a configuration KFAGTOR ﬂ a
To inatall 3 | o fi ati Entry Flow Rata 0.00 bbl/day 7
o install a previously saved device configuration Q: o oo bl Flow Totel ([60T gely
! L ¥ ‘
Previous Day Total 0.0 bbl il E “Bﬂﬂﬂ.’]
| o
& oo Stk  ——
MC-Hl detected - serial no. 4284967235 COMH v130 BHE2008 10:00:21 AM

Alvways daothe selected action on connection

LDorthW J| Cancel |

Figure 4.12—MC-IIl Main configuration option for complete access to configurable parameters

Device Autorun Options

What do pau want the prograrn to do?

E¥ MC-lll - <No Well Name >

_ : File View Options Help
3 Launch the Configuration Wizard =
5 v ; 5 h Q) ExittoMC-TIT Main | [ Export Grid To Excel &) Export Grid To Text [) LogData &S Print List “Z) Refresh List | 8 options -
which will step you though the basic zettings of the instrumel ;
Address Fiegister Name Data Tupe et Data Yalue [ystem Configuration
1000 Product Code 16-bit Integer 5 PR
F % 2 1001 R ter Table W 16-hit Ints
[T Go to MC-Ill Main e e
i | Whiere every feature of the MC-Il can be programmed £ 00: Maftaceli, ool 1€-bicInegar Cutput Carfguraion
EE ﬂ 5 1004 Sales Date 16-bit Integer | - -
6 to0s Serial Number High 16-bit Integer g R e
C &2 1008 Serial Number Low 16-bit Integer Control Registers.
Go to Advanced Access e -
Faor a directly r'l'liﬁrlif:ll.lliﬁtﬁ the M . = s 1008 Internsl System Sampla Period 16-bit Integer
. 10 1009 Portd - Slave Address 16-bit Integer
11 1010 PortD - Baud Rate 16-bit Integer
12 1011 Portd - Bus Delay 16-bit Integer
[[#) Download all logs , R
Al fotomatically retrieve all log data (daily, hourly, and eventz) 14 10w Comtract Hour 16-bit Integer
15 1014 Keypad Lock Code 16-bit Integer
16 1015 Keypad Lock Enable 16-bit Integer
r nuwnluad Dl'lly new Iugs 17 1018 LCD Contrast Setting 16-bit Integer
W Automatically retrieve unread log data (daily, hourly, and ever
Upload a configuration
To install a previously saved device configuration
addressing rmode: word Reverse Decode Byte Order 17 reqgisters
£ Getallpatal |setallpatal | Getpatum | | setpatum | ] Auto Seton Change [auto polling| Interval [4] 2 |»
COML v 130 BfHZ008 11:55:41 AM

Alvways do the selected action on connection

[ Do it Moy J | Cancel |

Figure 4.13—Advanced Access configuration option for system configurators and host programmers
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Configuration Wizard

The Configuration Wizard is ideal for first-time users who want to perform a basic calibration for liquid or gas
measurement. By following the instructions on nine screens, even a first-time user can successfully configure
the MC-IIT WP.

See Table 4.1, page 49, for a list of settings that are configurable with the keypad, the software Configuration
Wizard, and the software MC-III Main Screen.

Important: The Configuration Wizard does not allow multipoint calibration or gas volume
correction. To select these parameters, the user must access the MC-lIl Main screen.

Caution: Do not use the Configuration Wizard to change individual settings. When the Configura-
tion Wizard is used, system default settings are restored before the new settings entered
in the Calibration Wizard are written to the program. Previous configuration settings are
saved automatically in C:\NuFlo log data\MC-lI\Config Backup Files.

Using the Pencil Tool

The data entry fields in the Configuration Wizard are highly intuitive, and most can be completed by clicking
in the field and entering new data or selecting a checkbox. For data fields that require the user to enter a value,
such as a K-factor, and designate a decimal position, a pencil icon provides a link to a data-entry window.

To enter a new value, click on the pencil icon (Figure 4.14). A new window will appear, allowing the user

to enter a new value, and designate the appropriate decimal position using a slide bar. This method ensures
that the decimal point setting and data-entry resolution displayed in the software and on the instrument LCD
correlate.

This tool is used to enter the calibration factor, flow rates for 4-20 mA output, and the scale factor for pulse
output.
7 Configuration Wizard

STEP 4 of 9: Enter turbine K-factor

Turbine meters have a unique calibration factor (K-factor) th e i
corresponds to a certain unit volume. L EYCECEOMPEHIXE TS @

The turbine flowmeter K-factor is provided by the turbine m{  Enter digits and set decimal location:
tag fastened around the "neck" of the turbine meter.

) Hl|o||of|/o|| 9| of| o] O
Important: Note both the K-factor and the unit of volu

are expressed in pulses per U.S. gallon. Iéﬁl

To obtain your flowmeter calibration factor, the NuFlo o

(580-470-9600), or send email to nuflotegenuflotech.com [ oK ] [ Cancel ]

Enter your turbine meter's actor and units:

p00.0 pulsesfunit ¥ I Select from a list of typical K-Factors l
< Back I I Next > | I Cancel

Figure 4.14—Pencil tool icon and data-entry window
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Table 4.1—Menus for Configuring Parameters
Configurable Parameter Instrument Configuration Menu Screen For
Keypad Wizard (accessed from information,
MC-IIl Main) see page ...
Well Name — Step 1 Wellsite 58
Information

LCD Contrast — — System Setup 54
Security Setup — — System Setup 55
Contract Hour — Step 2 System Setup 54
Volume Display (units, Yes Step 5 Turbine Input 59
decimal location)

Rate Display (units, decimal Yes Step 5 Turbine Input 59
location)

Input Type Yes Step 3 Turbine Input 60
Input Sensitivity Yes — Turbine Input 60
Input Cut-off Thresholds — — Turbine Input 60
Calculation Period (seconds) — — Turbine Input 60
K-Factor Yes Step 4 K-Factor Entry 61
Multipoint K-Factor — — K-Factor Entry 62

Gas Volume Correction — — K-Factor Entry 63
4-20 mA Output Yes Step 6 4-20 mA Output 65
Pulse Output Yes Step 7 Pulse Output 69
Slave Address Yes Step 8 COM Port 56
Baud Rate Yes Step 8 COM Port 56

Bus Delay — — COM Port 57

Bus Timeout — — COM Port 57
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MC-IlIl Main Screen
The MC-III Main menu screen (Figure 4.15) is the configuration hub of the MC-III WP. From the Main
screen, users can

* review all current instrument settings and flow readings
» check the log archive and instrument status
* access all submenus for changing configurable parameters

¢ reset the total to zero

F¥ MC-111 - <No Well Name >

: File View Options Help

MC-1ll Main

-

SYSTEM Instrument Settings Archive Status
S ; Contract Hour 8:00 AM Daily Logs 51 unread, 384 max
(f:’;({; K-Factor 900.00 pulses/gal Hourly Logs 767 unread, 768 max
CD’M Calculation Period 4 seconds Events Logs 8 unread, 345 max

Port Flow Input Sensitivity Low sensitivity

: . Instrument Status
Ao ] Gas Volume Correction  OFF
Qs Supply Voltage ~ 3.61 V
WELLSITE
Information 4-20 mA Output OFF Battery Voltage  3.57 V
Int. Temperature  27.1 °C, 80.8 'F
m‘b Pulse Dutput OFF System Clock 08/16/08 09:56:47 AM
TURBINE
Input = —
o,

§ Flow Readings
Flow Total 753.4 bbl i / T,
K-FACTOR
Entry Flow Rate 0.00 bbl/day Flssar.
F!cw Tatal

@: Current Day Total 0.0 bbl GBBE 253"""
Previous Day Total 0.0 bbl = ANnN
420 ma Live Updawsk HHHHITE

W MC-1il EXP Flow Aruan
MC III detected - serial no. 4294367295 ¥130 BAE/2008 10:00:21 AM

Figure 4.15—MC-IIl Main screen provides direct access to all menu functions using the scrolling menu bar at
the left side of the screen.

Data Display and Updates

Each time the software polls the instrument, a small icon appears briefly in the lower left corner of the screen.
If the “Live Updates” checkbox in the lower right corner of the screen is checked, the instrument settings and
the LCD displays will automatically update with each poll.

“Live Updates” Checkbox

The “Live Updates™ option is enabled by default. However, in the event that slow communication speeds are
used or the system times out frequently, the user can uncheck the “Live Updates” checkbox and periodically
query the system by clicking on the LCD graphic on the Main screen.

Reset Flow Total Button
The flow total can be reset to zero at any time by clicking on the “Reset Flow Total” button.

Scroll Bar

A scroll bar at the left side of the screen (Figure 4.15) gives the user easy access to any of seven configuration
menus and two log archive screens (see pages 52 and 53). Using these menus, the user can change all
configurable parameters of the instrument. Once the instrument has been configured, the Main screen access
should always be used for changing individual parameters while retaining all other configuration settings.
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Buttons and Tools

Apply and OK Buttons

Changing parameters on a submenu screen involves selecting the proper screen from the scroll bar, selecting
information from dropdown menus or entering data in data fields, and saving the data using the “Apply” or
“OK” button. “Apply” allows the user to apply the changes without leaving the submenu screen. “OK” allows
the user to apply the changes and returns the user to the Main screen.

Refresh and Cancel Buttons

To update the display of settings on any submenu screen by forcing a reread of configured parameters, press
the “Refresh” button. The “Refresh” button clears any entry that has not been applied, therefore, pressing
“Refresh” is also a convenient way to erase an incorrect entry. A “Cancel” button allows the user to close out
of a submenu screen without saving new settings and returns the user to the Main screen.

Pencil Tool for Data Entry

The data-entry fields in the MC-III Main sub-menu screens are highly intuitive, and most can be completed
by clicking in the field and entering new data, or selecting a checkbox. For data fields that require the user to
enter a value, such as a K-factor, and designate a decimal position, a pencil icon provides a link to a data-entry
window.

To enter a new value, click on the pencil icon (Figure 4.16). A new window will appear, allowing you to enter
a new value, and designate the appropriate decimal position using a slide bar. This method ensures that the
decimal point setting and data-entry resolution displayed in the software and on the instrument LCD correlate.

This tool is used to enter the calibration factor, flow rates for 4-20 mA output, and the scale factor for pulse
output.

E¥ MC-11l EXP Interface - <No Well Name>
Eile Wiew Options Help

K-Factor Entry

=
Enter Device-Compatible Yalue

- K-Factor ? Enter digits and set decimal location:
WELL SITE Factor Units ulses/gal - | Ena
,‘:Tn:"‘?w P 9 o]/ o/|o|[s]/0l0lo
Factor Type Atmos] 3
* Linear 900.0)
TURBINE ) Multipoint points [ oK ‘ Cancel I
pue Freq (Hz] Factor - TTOTEITY
$_ o Pressure [absolute] Pressure [gauge)
K-FACTOR
&by Temperature Temperature
Compressibility Compressibility
3
Last backup: 04,/15/2005 0X12 PM
Vi Retrieve K-factor backup Calculate compressibility from gas comp. ‘
:!mf: ‘_
(Flefr‘esh) [ Apply ] ( oK ) (Cancel)
MC-1II EXP detected - serial no. 16 COM1L v 1.0.0 4/19/2005 2:01:50 AM -

Figure 4.16—Pencil tool icon and data-entry window
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Configuration Submenus (MC-Ill Main)

B MC-11l EXP Interfage - <Ho Well Hame=
Fl= Vew Options

Help.

System Setup

5;9:5” Product Name E-11 EXE) Keypad Lock O Erabled
1200
PFroduct Revision o Lock Code
Firmwars Version 160 [laheer il
Manufacture Date  01/2005 LCD Cantract i}
Sales Data 01/2005 — 1
Serial Number 16
Date and Time
Instrument Date  04/09/2005 Contract Hour 8:00 AM -
Instrument Time  08:22:10 PM

Sync to compu =

4-20 mA

com v 1.00

4/912008 B:22:08 PM

% MC-IIl EXP Interface - <No WellName>

Fle View Options Help
” Communications Port
Setup
 Port G
\)}{ Slave Address - 1 I+
com :
Port Baud Rate
S00 600 1200 2400 4800 9600 9600 19.2k 384k 57.6k 1152k
| 1 1 . 1 1 . 1 1 ,
WELLSITE f T T T T T T T T |
Information low power mode high power mode
Bus Delay — 10 + msec
TURBINE
fiats Bus Timeout = 50 + msec
Note: Low power mode is recommended for maximum battery life. High power mode is activated
K-FACTOR for baud rates above 8800 baud
Entry
4-20 mA
Output
MCHIIL EXP detected - serial no. 16 oML v 1.0.0 /92005 10:57:15 PM

System Setup

>l EXP Interface - <No Well Hame =

Fl= Wew  Cplins

Wellsite Information

Company Name
Well Name
Sita D

Sita Location

TagMama
Legal Description

Sensor Modal No.

Sensor Serial No.

Maasurement Type

User Note

PilLEE
MC-TI1 5P detected - serial n, 16

coM v 1.0.0

/912005 82534 PM

Communications Port

Turbine Input

~ Volume Display [~ Rate Display
Mulviplier [ x 1000 Multiplier [x1000
Uries T | | U oo
WELLSITE
i Time Base /day
Decimals 0000000.0 Decimals 0000.00
) K

- Input Bonfiguration - Cuteoff Thresholds

@ Turbine Input Low Frag. [He] 2

PULSE

o

MC-TI1EXF detected - serial no. 16 CoMi v 1.0.0

Senaitivity Low (~20 mv) = Flow Rate | [1.00
) Pulse Imput: bl day
Calculation Period — 4 + sec
Nate: Longer calculation periode result in higher flow rate resolutons and slower updatss.

(412005 826240 P

Wellsite Information

B MC-11l EXP Interface - <o Well Hame=
Fls Wew Optins

K-Factar Entry

telp

~ K-Factor i Gas Volume Correction
Factor Units [0t ] hd [] Enahle volume correction
Factor Type Atmospheric Pressure
(=) Lingar 900.00 2
) Multipaint points
Freq [Hz] Factor Base Working
& Prassure [absolute]  Pressure [gauge]
K-FACTOR
Entry Temperatura Temperatura
Compressibiling Compreasibiliy
"
Last backup: <nong =
. Ratriave K-factor backup | Galeylate compressibiity from gas comp.
M EXP detected - seralno, 16 com VOO | HE005 82802 PM

Turbine Input

& MC- 11l EXP. Interface - <No Well Name>
Eile

View  Options

4-20 mA Output

Help

Qutput Configuration

WELLSITE

4-20 mA Output

Low Flow Rate +® bbl/day
bt Flow rate that corresponds to 4 mA output
High Flow Rate 1700.00 ¥ bbl/day
Flow rate that corresponds to 20 mA output
K-FACTOR
Entry
Note: The 4-20 mA update rate is equal to the calculation period [4 sec).
4-20 mA
oupu || Testaaomoupur |

FLOW

MC-IIT EXP detected - serial no. 16 oM v 1.0.0

4132005 6:34:46 PM

K-Factor Entry

4-20 mA Output
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Configuration Submenus (cont’d)

v MCIIl EXP Interface - <No Well Name >

Eile

Vlew  Options  Help

WELLSITE

Pulse Output

Output Configuration

Pulse Output:
Pulse Duration — 100 + msec  Max. output frequency: 5.00 Hz
Scale Factor 1.00 S* bhbl

Note: Scale factor defines the volume represented by a single output pulse

Max. flow rate before pulse caching occurs:  482000.000 bbl/day

Note: Output pulse caching oceurs when the maximum output frequency is not fast enough to keep
up with the flow rate. This situation is normally not desirable. However. it can ocsur in applications
with short buret of high flow rate fi.e. separators, tank loading. dump cycles)

fl=s Test Pulse Output
Output

MC-ITI EXP detected - serial no, 16 comt v 1.0.0 4/9{2005 8:36:13 PM

Pulse Output

¥ MC- 11l EXP Interface - <No WellName>

Fle iiew Options Hep
Infarmat -
Flow Archive
Download = ‘ Mark Al as Read ‘ ExportData  ~ ‘ Print Table ‘ ‘
TURBINE
Far Contract Hour: 8:00 AM
Rec  Timestamp Flow volume (Std gal) Run Time (hh:mm:ss) Supply Yoltage (V) «
1
T 2 01/02/2004 08:00:00 598.6 24:00:00 2.920
Entry 3 01/03/2004 08:00:00 600.8 24:00:00 2.870
4 01/04/2004 08:00:00 602.9 24:00:00 2.840
5 01/05/2004 08:00:00 605.1 24:00:00 2.830
4-20 mA 6  01/06/2004 08:00:00 607.1 24:00:00 2.910
Output
2 7  01/07/2004 08:00:00 609.2 24:00:00 2.860
8 01/08/2004 08:00:00 611.2 24:00:00 2.910
9 01/09/2004 08:00:00 613.2 24:00:00 2.900
PULSE
o 10 01/10/2004 08:00:00 615.1 24:00:00 2.840
11 01/11/2004 08:00:00 617.0 24:00:00 2.860
12 01/12/2004 08:00:00 618.8 24:00:00 2.900
P 13 01/13/2004 08:00:00 6206 24:00:00 2.880 =
Archive Daily Logs (Hourly Logs | Daily Trend | Hourly Trend
MC-II1 EXP detected - serial no. 16 COML w1.0.0 4[13/2005 8:56:16 FM

Flow Archive

¥ MC-Ill EXP Interface - <No Well Name>

Ele View Options  Help

Event Archive

TURBINE
et D - || mark Allas Read Export Data, v Brint Table
Rec  Timestamp Status Address Register Name Old Value New Value =
K-FAGTOR “ 04/08/2005 16:21:57 & a2 Device Reset
Entry 2 01/01/2000 12:00:06 3 32 Device Reset
3 04/10/2005 09:02:57 0 12060 T1-CorrectionFactor 1.000000 7.363764
4 04/13/2005 08:13:40 8 32 Device Reset
4-20 mA 5 04/13/2005 11:42:20 o 12009 T1 -Factor Type 1.000000 3.000000
Theper 6 04/13/2005 11:42:20 © 12014 T1-Frequency2 1.000000 2.000000
T 04/13/2005 11:42:20 0 12016 T1-Frequency 3 1.000000 3.000000
& 04/13/2005 11:42:20 0 12018 T1-Frequencyd 1.000000 ©.000000
g:,’;:f 9 04/13/2005 11:42:20 0 12020 T1-Frequency 5 1.000000 0.000000
10 04/13/2005 11:42:20 0 12022 T1-Frequency 6 1.000000 0.000000
11 04/13/2005 11:42:20 © 12024 T1-Frequency 7 1.000000 0.000000
12 04/13/2005 11:42:20 0 12026 T1-Frequency 8 1.000000 0.000000
13 04/13/2005 11:42:20 0 12028 T1-Frequency 9 1.000000 0.000000
14 04/13/2005 11:42:20 © 12030 T1-Frequency 10 1.000000 0.000000 =
Event Lags
EVENT
Archive
WC-IIT EXP detected - serial no. 16 comt V100 | 4132005 11:44:51 AM

Event Archive
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System Setup

The first of the submenus on the Main screen scroll bar—System Setup—allows users to adjust time/date,
set the desired contract hour, enable or disable the password-protected security option, and adjust the LCD
contrast.

P& MC-111 EXP Interface - <No Well Name> g@@

Eile Wiew Options Help Testing

@ System Setup

S;:_:i“ Product Name Keypad Lock O Enabled
Product Revision 0o Lock Code
Firmware Version 1.00 lighter darker
Manufacture Date 05/2005 LCD Contrast aﬂﬂﬂﬂmggﬂﬂﬂﬂﬂﬂuﬂ
Sales Date 05/2005 — ] —
Serial Number 300000

Date and Time

Instrument Date 05/27/2005 Contract Hour 8:00 AM x

Instrument Time  02:05:22 P

Sync to computer time

(Refresn] ( Apoly ) ( ox ) (cancsl)

MC-IIT EXP detected - serial no, 300000 COML v 1.0.0 5/27[2005 2106:09 PM

Figure 4.17—System Setup screen

Time/Date Synchronization

The MC-III WP includes a real-time clock for timekeeping and log time stamps. Upon connecting with the
instrument, the interface software prompts the user to synchronize the instrument time and date with the
time and date displayed on the computer if the time difference exceeds 60 seconds. To change the clock
synchronization threshold to a value other than 60 seconds, see General Options, page A-1.

A user can synchronize the instrument and computer clocks at any time by clicking the “Sync to Computer
Time” button on the System Setup screen.

Contract Hour

Hourly flow totals are logged in the archive on the hour. The contract hour determines the exact time when
the daily flow total is logged. The contract hour is easily adjusted by selecting the appropriate hour from the
dropdown list on the System Setup screen.

LCD Contrast Adjustment
LCD contrast is temperature-dependent and may require adjustment for optimum readout visibility. A slide
bar allows users to quickly adjust the contrast of the LCD.
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Security Setup

Setting a keypad security code will prevent unauthorized personnel from altering calibration data or resetting
totals, and the security function is recommended to preserve data integrity of the system. The MC-III WP’s
keypad security feature is disabled at the factory.

To enable the security protection, check the “Keypad Lock™ checkbox on the System Setup screen, and enter
a four-digit lock code in the field below the checkbox. (Do not use “0000.”) The security feature will be
activated the next time a user attempts to access the keypad.

Firmware Version Number
As firmware is upgraded, firmware version numbers change. The firmware version number shown may assist
technical support personnel in troubleshooting an operational issue.

Serial Number
The serial number of your MC-III WP can be used to track the history of your unit to include warranty status.
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Communications Port

The Communications Port screen (Figure 4.18) allows users to change the settings that are required for
Modbus® communication.

ﬁ MC-1II EXP Interface - <Mo Well Mame >

Options  Help

File  ‘iew

Communications Port

 Port Configuration

7 4
%f Slave Address —
Part Baud Rate

200 600 1200 2400 4800 9600 S9S600 19.2k 384k 576k 1152k

------ low power mode high power mode
Bus Delay - 10 + msec
Bus Timeout —_ 50 <+ msec

Mote: Low power mode is recommended for maximum battery life. High power mode is activated
K-FACTOR for baud rates above SEO00 baud

Entry

(Faefresh] (Apnly] [ oK ] [r:amcel]

MC-II1 EXP detected - serial no. 16 COML v 1.0.0 4/9/2005 10:57:15 PM

Figure 4.18—Communications Port screen

Slave Address

The slave address allows the MC-III WP to communicate with other devices via Modbus®. It is a number
that ranges from 1 to 65535, excluding 252 to 255 and 64764. If a Modbus® request message contains the
matching slave address, the device will respond to the request. In network arrangements, the slave device
must have a unique address. For more information about Modbus® communications, refer to the protocol
manual section.

To change the slave address, select a number using the “plus” and “minus” buttons on the screen, or using the
page-up and page-down keys on your computer keyboard. If Modbus® communication is not used, leave the
slave address at the factory setting (1).

Baud Rate

The baud rate is the number of bits per second that are on the serial port. Baud rates supported by the MC-III
WP range from 300 to 115.2K. This setting must match the setting of the master device polling the MC-III
WP or the serial port. This only applies to the Modbus® communications; if Modbus® is not used, set the baud
rate to 9600.

To change the baud rate, slide the selector bar to the appropriate setting. The default setting is 9600 baud.
Note that the 9600 baud rate is available in both the low-power and high-power modes. When the instrument
is powered by batteries alone, the low-power mode is recommended.

Auto-Negotiate Option
When connected devices are capable of switching baud rates automatically or when devices are directly
connected to an MC-III WP, a user may configure the MC-III interface to automatically negotiate the fastest
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baud rate during device connection. This “negotiated” baud rate does not replace the configured baud rate,
but rather provides a temporary boost of baud rate while the computer is connected to the device for faster
downloads. After the software disconnects, the device reverts to the configured baud rate.

By default, this function is disabled. To enable automatic baud rate negotiation on device connect, choose
Options/Program Options from the menu bar, select Communications from the dropdown options list, check
the “Attempt auto-negotiation...” checkbox, and click “OK” (Figure 4.19). To initiate an immediate search
for the fastest baud rate without exiting tto the Welcome screen, check the “Enable auto-negotiated baud
rate” checkbox, click the “Test Now” button to the right of the checkbox, and click “Yes” at the prompt in the
Confirm dialog box. See also Auto-Negotiate Option, page A-4.

oo | — :
P Communications Options

Autorun

v | Always attempt Express Connect on program start-up
Dovvnloading

Attempt auto-negotiation of fastest baud rate on device connect
v| Toggle RTS line for RS-485 adapter transmit control

Enable Modbus address support for firmware versions 1.06 - 1.08

Timing Parameters

Presend Delay 0| msec Reset to Defaults

Number of Retries 2
Timeout Period Type Optimal (¢ Fixed
Timeout Period 5000| msec

Enable auto-negotiated baud rate (9600 baud) Test Now

Current link baud rate: 9600 baud

[ OK Jl Cancel J

Figure 4.19—Communications Options screen

Bus Delay

Bus delay is the amount of time (in milliseconds) that passes before the MC-III WP attempts to take control of
the RS-485 bus and transmit a message back to the requesting device. The MC-III WP responds very quickly
to incoming Modbus® requests—in some cases, too quickly. A configurable delay allows the user to control
this response time. A setting of 10 ms is normally sufficient, but may require adjustment when the MC-I11 WP
is communicating with a radio or other end device that responds more slowly.

Bus Timeout
Bus timeout is the amount of time (in milliseconds) that must pass to cause the MC-III WP to reset its internal
Modbus® message handler. The default value of 50 ms is normally sufficient.

Software Communication Options

The default timing parameters in the MC-III WP support communication with most radios and Modbus®
devices. However, if the MC-III WP is used with a device that has a very slow response time, it may be
necessary to adjust the timing parameters to enhance performance. For information about these parameters,
see Appendix A, Software Program Options.
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Wellsite Information

The Wellsite Information screen (Figure 4.20) allows users to enter information that distinguishes the wellsite,
such as company name, well name, and site location. While most of the fields on this screen are optional, a
well name should be assigned.

The well name (limited to 20 characters in length) will also serve as the name of the folder where flow logs
generated by the MC-III WP software will be archived. If a well name is not entered on this screen, logs will
be saved in a folder titled “NO_WELLNAME.”

EMC-III EXP Interface - =Mo Well Mame=

File Wiew Options Help

Wellsite Information

Company Mame |

Part Well Name

Lo St

=1 ) .
WELLSITE Site Location

Information

Tag MName
Legal Description
TURBINE Sensor Model No.

Input
Sensor Serial Mo.

Measurement Type
K-FACTOR
Entry User Note
4-20 mA
Output
[Hefresh] [ Apply _] [ OK ] [Dancel)
MC-III E¥P detected - serial no, 1007 ZOM1 v 1.0.0 6/17/2005 10:37:40 AM

Figure 4.20—Wellsite Information screen
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Turbine Input

The Turbine Input screen (Figure 4.21) allows users to configure the displays for volume and rate, select the
type of input to be used (turbine input or pulse input), determine cut-off thresholds for measuring flow, and
determine the display update frequency.

EMC-III EXP Interface - =No Well Mame=

File  Wiew

Options  Help

Turbine Input

Part  Volume Display  Pate Display

Multiplier [k Multiplier [1x1000
Units bbl * Units bbl &
Time Base /day >
g ‘% Decimals 0000000.0 Decimals 0000.00
- e B
TURBINE j
Input
 Input Configuration  Cut-off Thresholds
® Turbine Input Low Freq. [Hz] 2
K-FACTOR Sensitivity Low (~20 m¥) * Low Flow Bate  1.00
O Pulse Input [rate units] bbl/ day

Calculation Period — 4 + sec

Mote: Longer calculation periods result in higher flow rate resclutions and slower updates.

[F?efr‘esh] [Apply] [ OK ] [Dancel)

MC-IIT E¥P detected - serial no, 1007 COML v 1.0.0 61172005 10:37:03 AM

Figure 4.21—Turbine Input screen

Volume Display
The Volume display can be configured to display totals in one of five preprogrammed engineering units or in a
user-defined unit (for use with a calculated divisor).

Important: If volume is to be measured in user-defined units, the K-Factor unit must also be
entered as “pulses per unit.” For more information, see Entering a Calculated Divisor, page
29.

To display the volume in multiples of 1,000 units, check the “Multiplier” checkbox. Users can specify
decimal point position, from 0.1 to 0.0001 of a unit, using the slide bar on the Turbine Input screen.

Important: Before enabling or disabling the “x 1000 unit option for displaying flow totals, clear the
total display to zero. If the total is not cleared, the accumulated total displayed will repre-
sent a combination of two different units and will not provide an accurate flow reading.

Rate Display

The Rate display comprises two parts: a volume unit and a time-base unit. The volume portion of the Rate
display can be configured in one of five preprogrammed engineering units or in a user-defined unit (for use
with a calculated divisor).

To display the volume portion in multiples of 1,000 units, check the “Multiplier” checkbox.
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The time-base portion of the Rate display can be configured in one of four preprogrammed engineering units:
per day, per hour, per minute, or per second. Users can specify decimal point position, from no decimal up to
0.001 of a unit, using the slide bar on the Turbine Input screen.

Important: If the volume portion of the Rate display is to be measured in user-defined units, the
K-Factor unit must also be entered as “pulses per unit.” For more information, see
Entering a Calculated Divisor, page 29.

Input Type/Sensitivity Configuration

The MC-III WP accepts either a turbine input or a pulse input. When the turbine input is selected, the user can
also specify one of three sensitivity levels (low, medium, or high) to help minimize noise interference in the
signal reception. A “low” sensitivity setting will detect a signal of approximately 20 mV peak-to-peak, while a
“high” sensitivity setting will detect only signals that exceed 40 mV, peak-to-peak.

When a pulse input is selected, no sensitivity setting is required.

Cut-Off Thresholds

Periods of very low or interrupted flow can lead to inaccuracies in indicated flow totals. To help prevent these
inaccuracies, the user can establish cut-off thresholds to determine the minimum frequency and/or flow rate at
which a signal will be recorded.

The flow rate cut-off is a setpoint for the accumulation of flow time in the hourly and daily records, and can
be applied to either a turbine input or pulse input.

The frequency cut-off is reserved for the turbine input only. When the low-frequency cut-off is configured, the
MC-II WP will ignore inputs that are less than the user-entered value.

Calculation Period

The flow calculation period is the number of seconds that are allowed for calculating the flow condition. This
setting is easily adjusted with the “plus” and “minus” buttons on the screen, or the page-up and page-down
keys on your computer keyboard. Increasing this setting value results in flow rates with greater resolution.
This setting is also the time allowed for processing of display updates.

60



MC-1II™ WP Flow Analyzer Section 4

K-Factor Entry

The K-Factor Entry screen (Figure 4.22) allows users to calibrate the MC-III WP using a single calibration
factor from a turbine flowmeter or multipoint linearization. Users can also configure the MC-III WP to
compensate for the effect of pressure, temperature, and compressibility on gas volume measurements.

EMC-III EXP Interface - =No Well Mame=

Options  Help

K-Factar Entry

File  Wiew

 K-Factor  Gas Volume Correction
Factor Units mj [] Emable volume correction
Factor Type Atmospheric Pressure
) Linear 900.00 hs
TURBINE ) Multipoint points
Input Fraq [Hz) Eaan Base Working

Pressure [absolute] Pressure [gauge]

K-FACTOR
Entry

Temperature Temperature

Compressibility Compressibility

Lazt backup: <none =

[Fefr‘esh] [Apply_] [ OK ] [Damcel)

Retrieve K-factor backup

PULSE
Output

MC-IIT E¥P detected - serial no, 1007 COML v 1.0.0 61172005 10:35:32 AM

Figure 4.22—K-Factor Entry screen

K-Factor Units

K-Factor entry consists of selecting the K-Factor unit and type (linear or multipoint). In selecting the unit,
users can choose from five preprogrammed units (pulses per gallon, barrel, cubic meter, cubic foot, or liter). If
a calculated divisor is to be used, “pulses per unit” should be selected.

K-Factor Type

For linear calibration, the user need only select the Linear checkbox and enter the K-factor of the turbine
meter. To enter the K-factor value, click on the pencil icon to open a data-entry window (Figure 4.23). Enter
the digits, left to right, and adjust the slide bar to move the decimal point to the proper position.

Enter Device-Compatible ¥Yalue @

Enter digits and set decimal location:

Bl ol allal]|1]|2]]|3 4

—— —

o | [ e |

Figure 4.23—Data-entry screen for linear K-factor
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For multipoint calibration, the user selects the Multipoint checkbox, and then enters the number of calibration
points he desires using the “plus” and “minus” buttons on the screen or the page-up and page-down keys on

a computer keyboard. Up to 12 calibration points may be entered. Frequency and factor data-entry fields are
automatically activated for the number of calibration points selected. The user can then enter the appropriate
data for each point.

K-Factor Backup

Each time a calibration factor is entered or changed, the software prompts the user to copy the previous
settings to backup memory (Figure 4.24). In the event that an error is made while entering configuration
parameters, the user can restore the last saved set of configuration settings to the instrument.

Confirm

Changes detected in K.-Factor zettings.
Copy previous settings to backup rmemon?

Yes | l Mo

Figure 4.24—Prompt to copy previous calibration settings to backup

Select “yes” to save the previous calibration factor to memory. The date and time of this backup is displayed
next to the “Retrieve K-Factor Backup” button on the K-Factor Entry screen. Only the last saved backup can
be retrieved.

To retrieve the last saved K-Factor backup, perform the following steps:

1. Press the “Retrieve K-Factor Backup” button. A confirmation screen will appear with a prompt to proceed
or terminate the retrieval.

2. Press “yes” to retrieve the last backup.

3. Click “OK” or “Apply” to save the retrieved settings to the configuration file. Because the retrieval of
these settings represents a change to the current K-Factor settings, you will again be prompted to copy the
previous settings to backup.
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Gas Volume Correction (Supercompressibility Calculation)

Gas turbine meters are calibrated in actual cubic feet (ACF), and measure gas in actual cubic feet. In some
applications, a user may benefit from referencing gas measurements back to standard conditions by measuring
in terms of standard cubic feet (SCF). The MC-III WP makes this process quick and easy, by using fixed
average values for the flowing gas temperature and flowing gas pressure.

By default, this option is disabled.

To access this feature, check the “Enable volume correction” checkbox in the Gas Correction section of the
K-Factor screen. The “STANDARD” annunciator on the LCD will illuminate, and all other Gas Volume
Correction data fields will be activated (Figure 4.25).

EMC-III EXP Interface - =No Well HName=

File Wiew Options Help

 K-Factor  Gas Volume Correction
Factor Units Enable volume correction
Factor Type Atmospheric Pressure
O Linear 14.73 psi ¥
TURBINE -
ot ® Multipoint — 8 -+ points
a Freq [Hz] Factor Base Working
i 1 100 12521301 % Pressure [absolute] Pressure [gauge]
K-FACTOR 2 2 Le 14.73 psi +* 100 psi  ~
Entry 3 300 125.20001
4 400 125.34003 Temperature Temperature
5 500 126 60 P e
6 600 12597
7 700 12597 Compressibility Compressibility
8 800 12534 « 0.99786 0.98642
Last backup: 04,/13,8005 11:42 AM
PLLSE Retrieve K-factor backup Calculate compressibility from gas comp. |
Jutpu
[F?efr‘esh) ( Apply ] [ OK -J [Dancel)
MC-III EXP detected - serial no. 16 oML v 1.0.0 4/13/2005 8:32:31 PM

Figure 4.25—Gas volume correction settings on K-Factor Entry screen

Atmospheric pressure is set at 14.73 psia by default, but can be adjusted to local conditions.
To compensate the gas measurement to standard conditions, complete the following steps:
1. Enter the atmospheric pressure.

2. Enter the base pressure and unit. The base pressure is the pressure to which the gas will be compensated
(typically, 14.73 psia).

3. Enter the base temperature and unit. The base temperature is the temperature to which the gas will be
compensated (typically, 60°F).

4. Enter the working pressure and unit. The working pressure is the user-entered pressure that represents the
average working (flowing) pressure.

5. Enter the working temperature and unit. The working temperature is the user-entered temperature that
represents the average working (flowing) temperature.
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6. Enter a known compressibility factor, or press “Calculate compressibility from gas comp.” to view a

selection of gas compositions (Figure 4.26).

» To automatically calculate the compressibility factor, enter the gas composition and click on
“Calculate.” The software will calculate flowing gas compressibility in accordance with the

AGA-8 detail method.

*  The K-Factor Entry screen will reappear, and the calculated super-compressibility factor will be

displayed.

File  Wiew

Options

TURBINE

Input

K-FACTOR
Entry

PULSE

Output

E MC-1ILEXP Interface - <Mo Well Name >

Help

Gas Composition

Working Temperature:

Base Temperature:

Oxygen
i-Butane
n-Butane
i-Pentane
n-Pentane
rHexane
Heptane
mOctane
rrMonane
n-Decane

Total

SEE

B0 °F
0.00000 %
0.09770 %
0.10070 %
0.04730 %
0.03240 Y
0.06640 %
0.00000 94
0.00000 95
0.00000 %
0.00000 %
100.00000 %

| Calculate super compressibility factor and return to K-Factor page.

Worling Pressure: 100 psi

Base Pressure: 1473 psi A

Methane @' 2220 || %
Nitrogen 0.25950 04
Carbon Dioxide 0.59560 o4
Ethane 1.81860 94
Propane 0.45960 o4
Argon 0.00000 %
Water 0.00000 a4
Hydrogen Sulfide 0.00000 94
Hydrogen 0.00000 3%
Carbon Monoxide 0.00000 '
Helium 0.00000 oy,

Calculate
Cancel

| Return to K-Factor page without performing calculation.

MC-III E4F detected - serial no, 16

COML

v 1.0.0

4/10/2005 9:03:10 AM

Figure 4.26—Gas Composition screen
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4-20 mA Output

WARNING Do not make or break any connections on the 4-20 mA current loop unless the area is
f known to be non-hazardous.
Caution: Before performing any 4-20 mA calibration, ensure that all peripheral equipment con-

nected to the 4-20 mA current loop is either disconnected or disabled. Calibrating and
testing the 4-20 mA output feature on the MC-IIl WP with the peripheral equipment in
operation may cause false alarms or erroneous operation of the peripheral device or as-

sociated equipment.

The 4-20 mA Output screen (Figure 4.27) allows users to configure the MC-III WP to provide a 4-20 mA
output representing flow rate. Zero and full-scale values can be configured to represent any flow rate range
within the range of the flowmeter. A test mode function is also included, allowing a user to calibrate and/or
verify the output received by an end device.

EMC-III EXP Interface - =<No Well Name >

File  Wiew

Options  Help

4-20 mA Output

~ Output Configuration
420 A Ouput D mabiod
Low Flow Pate 0.00 ~® bbl/day
Flow rate that corresponds to 4 mA output
High Flow Rate 1700.00 ~® bbl/day

Flow rate that corresponds to 20 mA output

MNote: The 4-20 mA update rate is equal to the calculation period [4 sec).

4-20 mA
Qutput Test 4-20 mA Output

[Fiefr"esh) {Apnly] [ OK ) {Dancel)

MC-II1 E%P detected - serial no, 16 COML v 1.0.0 4/3/2005 8:34:46 PM

Figure 4.27—4-20 mA Output screen

The low (or zero) setting is the flow rate value that will produce a 4-mA output. The high (or full-scale)
setting is the flow rate value that will produce a 20-mA output. Typically, the high value is greater than the
low value; this scenario is defined as “direct mode” in Figure 4.28, page 66.

Alternatively, users may configure the 4-mA and 20-mA outputs to have an inverse relationship, such that the
high value is less than the low value. This scenario is defined as “indirect mode™ in Figure 4.28, page 66.
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_ (High > Low)
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Figure 4.28—Two options for configuring a 4-20 mA output

Flow rates in-between the minimum and maximum rate setpoints will result in an output of current between
4 mA and 20 mA according to the following calculation:

Ji _[[MAX_IMIN]
our ~ 11 1 5
High— Low

Where:
|

O

I

M

I

M

ur — output current

X[RATE cypy — Low |+ 1,

Ax— Maximum current output (20 mA)

= minimum current output (4 mA)

High = programmed flow rate that produces a 20-mA output

Low = programmed flow rate that produces a 4-mA output

CURR

RATE flow rate
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Enabling 4-20 mA Output
By default, the 4-20 mA output option is disabled. To enable this feature, perform the following steps:

1. Check the “Enable” checkbox.

2. Click on the pencil icon next to the Low Flow Rate field to launch a data-entry window (Figure 4.29) and
enter the “low” or “zero” flow rate value that will produce a 4-mA output. Adjust the decimal position,
if necessary, using the slide bar. A flow rate less than or equal to this minimum setpoint will result in an
output of 4 mA.

3. Click on the pencil icon next to the High Flow Rate field and enter the “high” or “full-scale” flow rate
value that will produce a 20-mA output. Adjust the decimal position, if necessary, using the slide bar. A
flow rate equal to or greater than this maximum setpoint will result in an output of 20 mA.

Enter Device-Compatible Yalue @

Enter digits and set decimal location:

Bl al|al|al|1]|2]| 3L 4

et

(o [(om ]

Figure 4.29—Data-entry screen for 4-20 mA low and high values

4-20 mA Output Testing
The MC-III software allows users to test the 4-20 mA output by entering an output current value and reading
the live value generated in response.

To use the test mode, press the “Test 4-20 mA Output” button at the bottom of the 4-20 mA Output screen.
The test page will appear (Figure 4.30, page 68), and the 4-20 mA Output option will be temporarily disabled.

To test the output, enter a value in the Output Current (mA) field, and press “Set Output.”
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EMC-III EXP Interface - <No Well Name=

File Wiew Options Help

Test 4-20 mA Output

Test 4-20 mA Output

Wyhen 420 ma Output is not Enabled, the output current can be controlled via MODBUS &,
Click the "Set Output" button to test this feature now [the 4-20 mA Output is automatically
dizabled when you are in this test page).
If 4-20 & Output is Enabled, =ettings applied in this manner are overridden during the next
flow calculation period.
Output Current [mA] m S Set Output
Live Value 4.000

4-20 mA

Output

Done
FLOW
MC-III ExP detected - serial no. 16 oML v 1.0.0 492005 §:35:53 PM

Figure 4.30—4-20 mA output test screen
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Pulse Output

The Pulse Output screen (Figure 4.31) allows users to configure the MC-III WP to provide a pulse output
representing increments in volume. A test mode function is also included, allowing a user to calibrate and/or
verify the output received by an end device.

EMC-III EXP Interface - =No Well Mame=

File  Wiew

Options  Help

Pulse Output

Output Configuration

S e Pulse Output
Pulse Duration = 100 + msec  Max. output frequency: 5.00 Hz
Scale Factor 1.00 + bhl

Mote: Scale factor defines the volume represented by a =ingle output pul=e.

Max. flow rate before pulse caching occurs:  432000.000 bbl/ day

Mote: Output pulse caching ocours when the maximum output frequency is not fast enough to keep
up with the flow rate. This situation iz normally not desirable, However, it can ocour in applications
with short burst of high flow rate [i.e. separators, tank loading, dump cyclesl

PULSE

Test Pulse Output
Output

[Heﬁ—esh) ( Apply ]

MC-II1 E¥P detected - serial no, 16

(o) &=

4/3/2005 2:36:13 PM

COML v 1.0,0

Figure 4.31—Pulse Output screen

Configuring Pulse Output

By default, the pulse output option is disabled to reduce current consumption. To conserve power, do not

enable this feature unless it will be used.
To enable the pulse output option, perform the following steps:

1. Check the “Enable” checkbox.

2. Enter the pulse duration value using the “plus” and “minus”
buttons on the screen, or the page-up and page-down keys
on a computer keyboard. The pulse length (pulse width)
determines the length of each output pulse in milliseconds
(ms).

3. Click on the pencil icon next to the scale field to open a
data-entry window (Figure 4.32), and enter the scale factor.
Adjust the decimal position, if necessary, using the slide bar.
The scale factor sets the volume increment that will cause a
pulse output to occur. The unit for this factor is determined
by the unit set for the volume display.

Enter Device-Compatible ¥alue @

Enter digits and set decimal location:

Hl|o||oflo]|1f|oollo
s
(0] l [ Canicel l

Figure 4.32—Data-entry screen for pulse
output scale factor

Note:

The scale factor can be any number; it is not limited to powers of 10 (1, 10, 100, etc.).
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In applications where high flow rates may occur for extended periods, pulses can be lost due to the
instrument’s inability to register the flow rate at the maximum output frequency. To avoid the loss of pulses,
users can raise the scale factor or shorten the pulse duration. The software calculates the maximum flow
rate that can be reached before pulse caching is likely to occur, and displays the information on the Pulse
Output screen. In applications where short bursts of high flow rates are common (separators, tank loading,
dump cycles, etc.), the displayed flow rate can exceed the maximum flow rate for short periods without
compromising the accuracy of the total represented by the pulse output.

Pulse Output Testing

The MC-III software allows users to test the pulse output by writing a value to the pulse accumulator. Such
tests can aid in troubleshooting problems with hardware compatibility, threshold settings, and pulse duration
settings.

To use the test mode, press the “Test Pulse Output” button at the bottom of the Pulse Output screen. The test
page will appear (Figure 4.33), and the Pulse Output option will be temporarily disabled.

To test the output, enter a value in the Pulse Count field, and press “Set Output.” The value in the Live Value

field will decrement to zero in accordance with the programmed pulse duration.

E MC-II EXP Interface - <No Well Name >

File

Help

Wiew  Options

Test Pulse Output

Test Scaled Pulse Output

When Fulse Output i= not Enabled, the pulze accurmulator contents can be controlled via
WMODBUS ®. Any value written to the accurmulator will begin pulsing out using the programmed
pulze duration. Click the "Set Output" button to test this feature now fthe Pulse Output is
autornatically dizabled when you are in this test page).

If Fulze Output = Enabled, settings applied in this manner are overridden during the next flow
calculation period.

Pulse Count ]ﬂ Set Dutput

Live Value 0

i |
&
PULSE
Output
Done
IMC-II1 EXP detected - serisl no, 16 COML v 1.0.0 4192005 5:37:02 PM

Figure 4.33—Pulse output test screen
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Saving and Uploading Configuration Files

The MC-III software allows a user to save configuration settings in a file that is stored on the user’s computer
and can be uploaded to the MC-III WP as needed. Configuration files are easily identified by the .mc3
extension. The default filename begins with “config” and uses the following structure:

File Format Filename Structure
.mc3 “config’<date (YYMMDD)> <time (hhmmss)>.mc3

Example: config050209133922.mc3 is a configuration file that was
downloaded on February 9, 2005 at 1:39:22 p.m.

Saving a Configuration File
To save current configuration settings for future reference, perform the following steps:

1. Select File>Save Configuration File (Figure 4.34). A “Save MC3 Configuration File” screen will appear,
prompting the user to save the file to the computer hard drive. The default directory is C:\NuFlo log data\
MC-IIN<WELL NAME>, however the user can specify a new location, if desired.

ﬁ MC-1Il EXP Interface - <No Well Name >

Eile \ View Options Help

{;} Return To Welcome Screen  Ctrl+Home

[] save Configuration File

@ Exit Ctri+x Archive Status
— Contract Hour 8:00 AM Daily Logs 2 unread, 384 max
/\/://’( K-Factor 900.00 pulses/gal HourlyLogs 41 unread, 768 max
S
com Calculation Period 4 seconds Events Logs 3 unread, 345 max
Part Flow Input Sensitivity Low sensitivity
. . Instrument Status
) Gas Volume Correction  corrected to
Qs 14.73 psi A, 60.0 °F Supply Voltage ~ 3.61 V
WELLSITE
Informesion 420 mA Output OFF BetieiviVoltansis > V)

Figure 4.34—File dropdown menu allows user to save a configuration file
2. Click “Save.” An “Information” window will appear to confirm that the file has been saved.

The “wellname” folder will bear the well name that appears on the Wellsite Information screen. If no well
name is entered on this screen, the folder will be named “NO_WELLNAME” (Figure 4.35, page 72).
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save MC3 Configuration File

Savejr | ) NO_WELLNAME

1

=~ ® cF E-

My Computer
flp Metwork, File: name: LJ Save
Places
Save as ype: |ME3 Config Files [*.mc3) LJ Cancel

Figure 4.35—Default directory for configuration files

Uploading a Configuration File
To upload a configuration file, perform the following steps:

1. From the Main screen, select File>Return to Welcome Screen (Figure 4.36).

2. Click on the LCD to connect to the MC-III WP.

3. Click “Upload a configuration” (Figure 4.37, page 73) and click “Do It Now.” A “Load MC3 Configura-
tion File” window will appear (Figure 4.38, page 73), displaying the contents of the configuration folder.

4. Click on the appropriate well name folder, select the configuration file of your choice, and click “Open.”
A “Progress” window will appear momentarily, followed by an “Information” window confirming the

upload.

ﬂ MC-1ll EXP Interface - <No Well Name >
File | View Options Help
[ Return To Welcome Screen Ctrl+Home

] save Configuration File

@ Exi Chrex
SeETUp

Contract Hour 8:00 AM
\/(:’f/ K-Factor 9123.4
5
com Calculation Period 4 seconds
ek Flow Input Sensitivity Low sensitivity
L: ] Gas Volume Correction OFF
e

Archive Status

Daily Logs 383 unread, 384 max
HourlyLogs 767 unread, 768 max
Events Logs 31 unread, 345 max
Instrument Status

Supply Voltage 3.58V

Figure 4.36—File dropdown menu allows user to return to the Welcome screen
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Device Autorun Options

What do you want the program to do?

Section 4

v, Launch the Configuration Wizard
Which will step you though the basic seftings of the instrument

| Go to MC-lll Main

r\, Download all logs
AVl Sutomatically retrieve all log data (daily, hourly, and everts)

Download only new logs

Automatically retrieve unread log data (daily, hourly, and events)

Upload a configuration

To install a previously saved device configuration

[
v

| Always do the selected action on connection

—>[ Do it Mow I I Cancel

Figure 4.37—Upload a Configuration option

Load MC3 Configuration File

Laok i |kj MNO_WELLMNAME ‘:‘j &= ek EB-

,] E\_confi
Recent

by Metwork, File name: |

j Open |
Flaces
Files of type: |MEI3 Config Files [*mc3) _:j Cancel

% |
Figure 4.38—Default directory for configuration files
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Advanced Access

System configurators and host programmers can also access the software through the Advanced Access menu
(Figure 4.39). This option provides access to the Modbus® registers for the MC-III WP. A series of tabs on
the right side of the screen (real time, input configuration, output configuration...) allows the user to view a
specific group of registers, or to view all registers in one list.

Important: The Advanced Access option is not required for the routine operation of the MC-lll WP,
and novice users should not access this portion of the software unless instructed to do
so by Cameron technical support personnel.

Data retrieved from the MC-II1 WP while in Advanced access mode can be logged to a file by enabling the
“Automatically log data polls” checkbox on the Advanced Options screen. The file will include values that are
retrieved from the instrument when the user clicks the “Get All Data” button or enables “Auto Polling” on the
Advanced Access screen. See also Automatic Data Logging, page A-6.

E M-Il EXP Interface - sNo Well Hame =

File View Options Help
u Exit Advanced Mode Export Grid To Excel :@ Export Grid To Text Log Data @ Print List ﬁ Refresh Lisk P:l Options -
fddress Fegister Hame Dista Type Hex Dista Walue system Configuration ||
1ooo1 Praduct Cade 16-hit Integer f =

= toooz Register Table Yersian 16-hit Integer ! RelTing

3 10003 Firmwara WVerzion 16-bit Integer Input Configuration

4 10004 Manufacture Date 16-hit Integer Cutput Sonfiguration

5 1000s Sales Date 16-bit Integer

& 10006 Serial Mumber High 16-bit Integer Holdnig Redltlets

7 10007 Serial Mumber Low 16-bit Integer Contral Registars

g8 1o00s Pawer Mode 16-bit Integer AL

9 1ooo0e Internal System Sample Period 16&-bit Integer

10 10010 Part - Slave Address 16-bit Integer

11 10011 PortO - Baud Rate 16-bit Integer

1z 10012 Portd - Bus Delay 16-bit Integer

13 10013 Port - Bus Timeout 16-bit Integer

14 10014 Contract Hour 16-bit Integer

15 10015 Eeypad Lock Code 16-bit Integer

16 10016 Eeypad Lock Enable 16-bit Integer

1o 10017 LD Contrast Setting 16-bit Integer

addressing mode: word Reverse Decode Byte Order 17 registers

Get All Data | Set All Data Get Datum Set Datum «| Auto Set on Change Auto Polling | Interval |— il -+
COM1 v 1.0.0 4/9j2005 11:34:49 PM

Figure 4.39—Advanced Access screen
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Section 5—Flow Logs and Event Logs

The MC-III™ WP’s flow archive expands the user’s ability to track flow volume over time by allowing the
user to view flow data in tabular and trend formats, to save or print log data in reports, and to export log data
into a spreadsheet. Additionally, an event archive allows users to identify changes to configuration parameters
and other settings for troubleshooting operational issues.

A user can download logs from the Flow Archive and Event Archive screens as needed, or configure the
software to automatically download the logs upon connection with the instrument. See Automating Functions
on Software Startup, page 41, for more information.

When the “download all logs” or “download only new logs™ option is selected from the Device Autorun
Options menu and the “Always do...” checkbox is checked, the software will download both flow logs and
event logs each time the software connects to the MC-III WP (Figure 5.1).

Device Autorun Options

What do pou want the program to do?

o Launch the Configuration Wizard

Which weill step wou though the basic settings of the instrument
[T Goto MC-ll Main

I ﬂ Wwhere every feature of the MC-ll can be programmed

Go to Advanced Access

For advanced users to directly manipulate the MODBUS registers
r‘ Download all logs
Automatically retrieve all log data (daily, hourly, and everts)
KP Download only new logs

Avtomatically retrieve unresd log data (daily, hourly, and events)

Upload a configuration
Toinstall & previouzly saved device configuration

< |

v | Always dothe selected action on connection

[ Dol Moy J | Cancel |

Figure 5.1—Device Autorun Options screen allows automated log downloads with every connection
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Auto-Save Log Formats

The MC-III WP automatically saves daily flow logs on the contract hour, and saves hourly flow logs around
the clock. The instrument also automatically saves an event log each time a user change is made. After
downloading these logs from the instrument, the software saves the data in a file. By default, the logs are
saved as .csv files.

The file format of the auto-save flow log and event log files is user-configurable. To save logs in Excel (.xls)
format, click Options>Program Options in the task bar, select Downloading from the dropdown options list,
and check the “XLS-MS Excel File” checkbox (Figure 5.2).

.Options . =
saril Downloading Options

Aukarun
Cammunications
Downloading

Auto-save log file type

5% - Comma-separated values text file
# ¥LS - M3 Excel file

Advanced

| ] Use gquake character (") as a delimiter in C5Y file exports
Auktomatically mark new records as read after downloading

|| Round Flow values ko number of decimal places set For Flow Yolume Display

oK | | Cancel

Figure 5.2—Log download options

Log Directory and Filenames

Auto-save log files are saved in C:\NuFlo log data\AMC-IIN<WELL NAME>. The “wellname” folder will bear
the well name that appears on the Wellsite Information screen. If no well name is entered on this screen, the
folder will be named “NO_WELLNAME.”

Log filenames incorporate the serial number of the MC-III WP, the date, the time, and a capital letter
indicating the log type, as shown below.

File Format Filename Structure

Xls or .csv | <Serial number>_<date (YYYYMMDD)>_<time (hhmmss)>_<log
type indicator> where the log type indicator is
“H” for hourly, “D” for daily, or “E” for event

Example: 16_20050302_102031_H.xIs is an hourly log file from the
MC-1Il WP serial number 16 that was downloaded on March 2, 2005
at 10:20:31 AM.

76



MC-1II™ WP Flow Analyzer Section 5

Flow Archive

The MC-III WP automatically saves daily flow logs on the contract hour, and hourly flow logs. The Flow
Archive screen (Figure 5.3) allows users to download, view, and print trend charts, and export daily and
hourly logs. On the Flow Archive screen, users can view up to 384 daily logs and 768 hourly logs in tabular
format (note the Daily Logs and Hourly Logs tabs at the bottom of the screen), or in a trend chart (see Daily
Trend and Hourly Trend tabs).

EMC-III EXP Interface - =No Well HName=

File Wiew Options Help
Flow Archive
Download - | Mark All as Read | Export Data = Print Table | |
TURBINE
Contract Hour: 8:00 A
Rec  Timestamp Flow volume (bbl) =
1 |01/01f2004 08:00:00 14.2
K-FACTOR 2 01/02/2004 08:00:00 14.3 24:00:00 2.830
Entry 3 01/03/2004 08:00:00 14.3 24:00:00 2.910
4 01/04/2004 08:00:00 14.4 24:00:00 2.820
5 01/05/2004 08:00:00 14.4 24:00:00 2.910
6 01/06/2004 08:00:00 14.5 24:00:00 2.820
7 01/07/2004 08:00:00 14.5 24:00:00 2.830
8 01/08/2004 08:00:00 14.6 24:00:00 2.860
9 01/09/2004 08:00:00 14.6 24:00:00 2.910
10 01/10/2004 08:00:00 14.6 24:00:00 2.820
11 01/11/2004 08:00:00 14.7 24:00:00 2.830
. 12 01/12/2004 08:00:00 14.7 24:00:00 2.900
FLOW 13 01/13/2004 08:00:00 14.8 24:00:00 2.840 o
Archive Daily Logs (Hourly Logs | Daily Trend | Hourly Trend
MC-IIIT E¥P detected - serial no, 16 ZOM1 v 1.0.0 4/18/2005 1:43:20 PM

Figure 5.3—Flow Archive screen

Downloading Flow Logs

To download flow logs, click the “Download” button on the Flow Archive screen, and select either Download
All Flow Logs or Download Only New Flow Logs (Figure 5.4, page 78). (Download Only New Flow Logs
will display only flow logs that have been created since the last download was performed.) Tabular views of
the archive record (Figure 5.5, page 78) include a time stamp showing the exact time each log was recorded,
as well as flow volume, run time, and supply voltage. Trend views (Figure 5.6, page 79) show the flow
volume and time stamp only.
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EMC-III EXP Interface - <No Well Name>
- File

Options  Help

Yiew

Flow Archive

TURBINE Reqt Export Data ~ Print Table I ? |
Input Download All Flow Logs
Download Only New Flow Logs
———— Y 9°_Jow volume Run Time (hh:mm:ss) Supply Voltage (V)
3
K-FACTOR
Entry
4-20 mA
Output
PULSE
Output
FLOW
Archive
Daily Logs (Hourly Logs | Daily Trend | Hourly Trend
EVENT
MC-III EXP detected - serial no. 16 COM1 v 1.0.0 4/18/2005 1:22:20 PM

Figure 5.4—Menu for downloading flow logs from the Flow Archive screen

ell Name u

AL LA

File View Options Help

Infarmation

s, 4 2
Download  ~ I WarkaslllasiRead | Export Data ~ | Print Table | v l
TURBINE
Input Contract Hour: 8:00 AM
Rec Timestamp Flow Yolume (Std gal) Run Time (hh:mm:ss) Supply Voltage (¥) 4
> 01/01/2004 08:00:00 506.3 24:00:00 2.830 ]
K—FII‘C T0R 2 01/02/2004 08:00:00 598.6 24:00:00 2.920
Entry 3 01/03/2004 [TTIE 2.870
4 |01/04/2004 Reading Hourly Logs 2810
|01 /05/2008 ANRNNNENNNNNNNNNENENEEERREN 23
4-20 mA 6 01/06/2004 Elapsed time: 00 min:33 sec (9600 baud) 2.910
SEpLE 7 01/07/2004 2.860
Cancel
8 01/08/2004 2.910
9 01/09/2004 08:00:00 613.2 24:00:00 2.900
PULSE
Output 10 01/10/2004 08:00:00 615.1 24:00:00 2.840
11 01/11/2004 08:00:00 617.0 24:00:00 2.860
12 01/12/2004 08:00:00 618.8 24:00:00 2.900
FLOW 13 01/13/2004 08:00:00 620.6 24:00:00 2.880 =
Archive Daily Logs (Hourly Logs | Daily Trend | Hourly Trend
’b comt v 1.0.0 4/13/2005 8:03:32 PM

Figure 5.5—Downloaded flow logs (tabular view)
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Viewing Trend Charts

In the daily and hourly trend views, flow volumes are charted on a grid, with flow record numbers forming
the horizontal axis, and flow volumes shown on the vertical axis. A graphical line defined by two yellow
endpoints represents the range of archived logs available for viewing. A yellow triangle marks the first record,
and a yellow circle marks the final record. The arrowhead cursor is paired with a dotted circle. As the user
drags the cursor across the chart, the circle’s position corresponds with the record displayed at the top of the
screen (Figure 5.6). The circle’s snap function allows the user to pinpoint transitional points within the trend
display; the greater the zoom, the more precise the navigation.

Important: The interactive cursor cannot be turned off.

* To zoom in, left-click and drag the mouse to the right and down.
» To zoom out, drag the mouse up and to the left.

*  To reposition the chart within the viewing window, right-click the chart and move the mouse slowly in
any direction.

* To exit the page and return to the Main screen, press OK.

F¥ MC-11l EXP Interface - <No Well Name > g@@

Eile  Wiew Options Help Testing

Flow Archive

IRBINE Download - | | Export Data - | Print Chart | 7

Contract Hour: 8:00 AM

{Rec 118: 15.889bb] at 4/27/2004 §:00:00 AM)
Flow Volume Daily Trend

1 32 64 96 128 160 192 224 256 285 320 352 354
Log Record Mumber (starting at 1)

Daily Logs | Hourly Logs | Daily Trend {Hourly Trend

MC-TII EXP detected - setial no, 300000 ComM1 v 1.0.0 £12/2005 5145132 AM

Figure 5.6—Flow Archive screen, trend view

Printing/Saving a Report
A flow log can be printed and/or saved as a table (Figure 5.7, page 80) or a trend chart (Figure 5.8, page 81).

To print a log, select the appropriate tab at the bottom of the Flow Archive screen, and press the “Print”
button in the upper right corner of the Flow Archive screen. (If the display is tabular, the button will read
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“Print Table”; if the display is a chart, the button will read “Print Chart.”) A Print Preview screen will appear,

displaying the image to be printed.
To print the report, select File>Print from the task bar (Figure 5.7).

E Print Preview.

S View Format  Go

:@' Design...

‘MC-III Dty Log Download
‘Downloaded at; 09/182008 09:29 AM
‘Software Version: 1.3.0

"Firmware Version: 2.00

iProduct ID: 1

iProduct Rew: 0

Chr+P
Page Setup...

Options...

Close

Chrl+D S0 B B 22080 5B s =l =i I
Rebulld  Ctr+FS
= Load... o 0.5 Top: 0.5 Right: 0.5 Bottorm: 0.5" Header: 0.2" Footer 0.2
n Save. . Chrl+s

Well Name

e 1D

'Site Location

iTag Matne:

iSerial No: 1329

Fec Tiraestarap Flow Volume (bbI) Ran Time (hhumrss) Supply Voltage (V)
1 (08/29/2008 08:00:00 0.0 0:00:00 3.563
2 0830/2008 08:00:00 0.0 0:00:00 3.563
3 08/31/2008 08:00:00 0.0 0:00:00 3.508
4 02/01/2008 08:00:00 0.0 0:00:00 3574
& 09/02/2008 08:00:00 0.0 0:00:00 3574
[ 09/03/2008 08:00:00 0.0 0:00:00 3574
7 09/04/2008 08:00:00 0.0 0:00:00 3.508
8 |0%/05/2008 08:00:00 0.0 0:00:00 3.568

Figure 5.7—Print preview, tabular view

To save the report, perform the following steps:

1. Select File>Save from the task bar (Figure 5.8, page 81). A “Save Report As” window will open (Figure

5.9).

Enter a filename. The filename extension will be .rps.

Click “Save.” By default, log archive reports are saved in C:\NuFlo log data\AMC-IIN<WELL NAME>,

however the user can specify a new location, if desired. The “wellname” folder will bear the well name
that appears on the Wellsite Information screen. If no well name is entered on this screen, the folder will

be named “NO_WELLNAME.”
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W Print Preview

Y view Format Go

3B Desic BT ® w5 R al* .0 =

& Load...  Cbl+O

Top: 05"  Right: 05" Baottam: | 0.5" Header: | 0.2" Footer: | o.z"

& prirt... Chri+P
Page Setup...

Close ‘ 6.2

aptons... Flow Volume Daily Trend

Flow Volume (bbl)
=
o
1
e

1 32 64 96 128 160 192 224

256

288 320

Figure 5.8—Print preview, trend view

Save Report As

Savein: | =) NO_WELLNAME =] £ El- Presview:

BIX

%
11

My Metwork — File name: || lJ Save
Places
Save as type |Heport Files [*rps] LJ Cancel

[None)

Figure 5.9—Save Report As screen

Viewing a Saved Report

To view a saved report, perform the following steps:

1. From the Flow Archive screen, click “Print Table” (or “Print Chart” for trend chart views) in the upper

right corner of the screen.

2. Select File>Load from the task bar at the top of the page (Figure 5.10, page 82). A Load Report window

will open (Figure 5.11, page 82).

81



Section 5 MC-1II"™ WP Flow Analyzer

3. Click on the report you wish to view. A preview of the report will appear in the right portion of the win-
dow.

4. Click “Open.”

E Print Preview

GIEN iew Format  Go

Boeson.. w0 b S @EN SO0 0B 00 | =| > »| R

Rebuild  CkrH-FS

05" Top: 05" Right: 05" Bottom: 05" Header: 02" Footer: 0.2

Chrl+O

H Save.., Ctrl+5 |

& b - N MCHI Daily Log Dawnload T
e hat ‘Downloaded at: 09/18/2008 0940 AM
Page Setup... Software Version; 1.3.0
Options. .. ‘Firmwrare Version: 2.00
‘Product ID: 1
Clase ‘Product Rev: 0

Tell Narme:

Site 1D:

'Site Location:

‘Tag Name:

iserial Moo 1329

Fec Timestarap Flow Volurne (bhl) o Time (hbemrmiss) Supply Voltage (V)
1 08/29/2008 08:00:00 0.0 0:00:00 3.563
2 08/30/2008 08:00:00 0o 0:00:00 3503
3 08/31:2008 08:00:00 0.0 0:00:00 3508
4 09/01.,2008 08:00:00 0.0 0:00:00 3574
5 09022008 08:00:00 0.0 0:00:00 3574
[ 09/03/2008 08:00:00 0.0 0:00:00 3574
7 09/04/2008 08:00:00 0o 0:00:00 3508
8 09052008 08:00:00 0.0 0:00:00 3508
0 DOUNE NG 00 0000 0L D00 00 2570

Figure 5.10—Menu for loading a saved report

Load Report @@

Laok jn: | (29 NO_WELLNAME | cF Bl Preview: _@
- : -
Recent
(I_
Deskiop Fec Timestarmp
- 1 010172004 08:00:00
‘_’_] 2 01/02/2004 02:00:00
iy Documents 3 014032004 02:00:00
. 4 01042004 02:00:00
.-ig 3 010572004 08:00:00
by Computer &  |01/06/200408:00:00
‘;_. T 01072004 02:00:00
j b3 01022004 02:00:00
My Network File name: |Dail_|,l Logs.ips j Open | 0 010952004 02 00-00
Places £
Files of type: [Report Files [*.ps) ~| Cancel 10 |0110/200408:00.00
11 (0171172004 020000
12 (014272004 020000
- M e S e e b
< >

Figure 5.11—Load Report screen for viewing saved flow log reports
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Exporting Flow Logs
Flow logs can be directly exported to an .xls or .csv file for ease in viewing and distributing. To export a file,
perform the following steps:

1. Click the “Export Data” button near the top of the Flow Archive screen and select the .xls or .csv format
(Figure 5.12).

2. When the “Export Daily (or Hourly) Log Data...” window appears, click “Save.” By default, exported
logs are saved in C:\NuFlo log data\AMC-IIN<WELL NAME>, however the user can specify a new loca-
tion, if desired (Figure 5.13, page 84). The “wellname” folder will bear the well name that appears on

the Wellsite Information screen. If no well name is entered on this screen, the folder will be named “NO _

WELLNAME.”

Important: Users can also specify the file format to be used for all auto-save logs (.csv or .xls). To
change the auto-save format, follow the procedure described in Downloading Options,

page A-5.
P MC-11I EXP Interface - <Np Well Name>
File Wiew Options Help
Flow Archive
Download - | Mark All as Read | Export Data - | Print Table ‘ |
TURBINE .
Input Contract Hour: 8:00 AM Export Daily Logs to CSY
E t Daily L to ¥LS

Rec  Timestamp Flow Yolume—— :ipnr 2l y_ogso Supply Yoltage (V)  ~
K-FACTOR 2 01/02/2004 08:00:00 14.3 24:00:00 2,920
En 3 01/03/2004 08:00:00 14.3 24:00:00 2.870
4  01/04/2004 08:00:00 14.4 24:00:00 2.840
5 01/05/2004 08:00:00 14.4 24:00:00 2.830
6 01/06/2004 08:00:00 14.5 24:00:00 2.910
7 01/07/2004 08:00:00 14.5 24:00:00 2.860
8 01/08/2004 08:00:00 14.6 24:00:00 2.910
9 01/09/2004 08:00:00 14.6 24:00:00 2.900
10 01/10/2004 08:00:00 14.6 24:00:00 2.840
11 01/11/2004 08:00:00 14.7 24:00:00 2.860
2 12 01/12/2004 08:00:00 14.7 24:00:00 2.900

FLOW 13 01/13/2004 08:00:00 14.8 24:00:00 2.880 -

Archive Daily Logs |Hourly Logs | Daily Trend | Hourly Trend
MC-IIT EXP detected - serial no, 16 COM1 ¥ 1,00 | 4/13/2005 11:17:09 AM

Figure 5.12—Dropdown menu for exporting log data
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Export Daily Log Data to CSY

Saveir | () NO_WELLNAME =] £¥ E-
! ) 16_20050301_170140_D.csv
.—-J ] 16_20050301_170140_E.csv
Recerit #]16_20050301_170140_H.csv
] 16_20050302_091647_D.csv
Fra H)16_70050302_091647_F.csv

%) 16_20050302_091647_H.csv
Desktop 3916 20050302_102031_D.csv
1620050302 102031 H.csv
16_20050302_102339_D.csy
%) 16_20050302_102339_H.csv
%) 16_20050309_085941_D.csv
. %) 16_20050309_085541_H.csv
v 34294967205_20050301_165545_E.csv
3)4294967295_20050301_165656_E. csv

ty Computer

-
Ay Metwork, File name:
Places

j Save |
LJ Cancel

Save az wpe: |Te;-:t Data Files [*. cav]

Figure 5.13—Default directory for exported log files

Event Archive

The Event Archive screen (Figure 5.14) allows users to download, view, export, and print up to 345 user event
logs. Event logs are generated to track user changes such as K-Factor changes, input setting changes, power-
on and “watch-dog” resets, and the flow and frequency cut-off settings.

E MC-1II EXP Interface - <No Well Name =
File Yiew Options Help
Event Archive
TURBINE
L Dovnload - ‘ Mark All as Read Ezport Data = Print Table
Rec Timestamp Status Address Register Name 0ld value New Value &
K-FACTOR - 04,/08,/2005 16:21:57 8 3z Device Reset
Entry 2 01/01/2000 12:00:06 3 3z Device Reset
3 04/10/2005 09:02:57 (1] 12060 T1 - Correction Factor  1.000000 T.363764
4 04/13/2005 08:13:40 8 3z Device Reset
5 04/13/2005 11:42:20 (1] 12009 T1 - Factor Type 1.000000 3.000000
6 04/13/2005 11:42:20 (1] 12014 T1 - Fr y 2 1 2
7 04/13/2005 11:42:20 (1] 12016 T1 - Frequency 3 1.000000 3.000000
8 04/13/2005 11:42:20 (1] 12018 T1 - Fr ¥4 1 0
9 04/13/2005 11:42:20 (1] 12020 T1 - Frequency 5 1.000000 0.000000
10 04/13/2005 11:42:20 (1] 12022 T1 - Frequency 6 1.000000 0.000000
11 04/13/2005 11:42:20 (1] 12024 T1 - Fr ¥y 7 1 0
ELOW 12 04/13/2005 11:42:20 (1] 12026 T1 - Frequency & 1.000000 0.000000
Archive 13 04/13/2005 11:42:20 (1] 12028 T1 - Frequency 9 1.000000 0.000000
vl 14 04/13/2005 11:42:20 (1] 12030 T1 - Fr ¥ 10 1 0 2
1’2‘#{) | Event Logs
L
EVENT
Archive
MC-III EXP detected - serial no. 16 COML v 1.0.0 4/13/2005 11:44:51 AM

Figure 5.14—Event Archive screen
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Downloading Event Logs

To download event logs, click the “Download” button on the Flow Archive screen, and select either
Download All Event Logs or Download Only New Event Logs, (Figure 5.15). (Download Only New Event
Logs will display only flow logs that have been created since the last download was performed.) Tabular
views of the archive record (Figure 5.16, page 86) include a time stamp showing the exact time each log was
recorded, as well as the name of the register changed, and the old and new values assigned to that register.

m MC-11I EXP Interface - <No Well Name >

File View Options Help
Event Archive
TURBINE
Input Download v | ViarkasllasRead Export Data ~ Print Table
Download All Event Logs
Download Only New Event Logs \ddress  Register Name Old value New Value
K-FACTOR
Entry
4-20 mA
Output
PULSE
Output
FLOW
Archive
T Event Logs
Archive
MC-III EXP detected - serial no. 16 com1 v 1.0.0 4/19/2005 10:47:13 AM  .:

Figure 5.15—Menu for downloading event logs from Event Archive screen
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File View Options

EMC-III EXP Interface - <No Well MName=

Help

Event Archive

Download

- | Mark All as Read

Rec

Wom o~ ;Mmoo AW N

14

;.n-_’;:#) :
-

EVENT
Archive

Timestamp

“ 04/08/2005 16:21:57

01,/01,/2000 12:00:06
04,/10/2005 09:02:57
04,/13/2005 08:13:40
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20
04/13/2005 11:42:20

Event Lugs

MC-IIT E¥P detected - serial no, 16

Status  Address

8

o 2 2 2 2 2 2 o0 o o 8 0 W

32

32

12060
32

12009
12014
12016
12018
12020
12022
12024
12026
12028
12030

Export Data = Print Table

Register Name 0Old Value New ¥alue =

Device Reset

Device Reset

T1 - Correction Factor  1.000000 7.363764

Device Reset

T1 - Factor Type 1.000000 3.000000

T1 - Fr ¥ 2 1 2,

T1-Fr ¥ 3 1 3.

T1 - Fr v 4 1 0

T1-Fr ¥ 5 1 0.

T1-Fr ¥ b 1 0.

T1-Fr ¥ 7 1 0.

T1-Fr ¥ 8 1 0.

T1-Fr ¥ 9 1 0.

T1-Fr y 10 1 0. b
oML v 1.0.0 4/19/2005 2:49:12 PM

Figure 5.16—Downloaded event logs

Printing/Saving a Report
To print an event log, press the “Print Table” button in the upper right corner of the Event Archive screen. A
Print Preview screen will appear, displaying the image to be printed.

To print the report, select File>Print from the task bar.

To save the report, perform the following steps:

1. Select File>Save from the task bar. A “Save Report As” window will open.

2. Enter a filename. The filename extension will be .rps.

3. Click “Save.” By default, log archive reports are saved in C:\NuFlo log data\AMC-IIN<WELL NAME>,
however the user can specify a new location, if desired.The “wellname” folder will bear the well name
that appears on the Wellsite Information screen. If no well name is entered on this screen, the folder will
be named “NO_WELLNAME.”

The procedure for printing and saving an event log report is nearly identical to the procedure for printing and
saving a flow log report. See the flow log screen captures, pages 80 through 82, for reference.

Exporting Event Logs

Event logs can be directly exported to an .xIs or .csv file for ease in viewing and distributing. To export a file,

perform the following steps:

1. Click the “Export Data” button near the top of the Event Archive screen and select the .xls or .csv format

(Figure 5.17, page 87).
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2. When the “Export Event Logs...” window appears, click “Save.” By default, exported logs are saved in
C:\NuFlo log data\AMC-IIN<WELL NAME>, however the user can specify a new location, if desired. The
“wellname” folder will bear the well name that appears on the Wellsite Information screen. If no well
name is entered on this screen, the folder will be named “NO_WELLNAME.”

Important:

Users can also specify the file format to be used for all auto-save logs (.csv or .xlIs). To
change the auto-save format, follow the procedure described in Downloading Options,
page A-5.

5 MC-1Il EXP Interface - <No Well Name>

File View Options Help
Event Archive
TURBINE
Input Download v l Mark All as Read | Export Data ~ I Print Table
Export Event Logs to CSY
Rec Timestamp Status Address Export Event Logs to XLS New Value -
K-FACTOR - 04/08/2005 16:21:57 8 32 Device Reset
Entry 2 01/01/2000 12:00:06 3 (32 Device Reset
3 04/10/2005 09:02:57 (1] 12060 T1 - Correction Factor 1.000000 7.363764
4 04/13/2005 08:13:40 8 32 Device Reset
4-20 mA 5  04/13/2005 11:42:20 0 12009 T1 - Factor Type 1.000000 3.000000
RPT 6 04/13/2005 11:42:20 0 12014 T1 - Frequency 2 1.000000 2.000000
7 04/13/2005 11:42:20 0 12016 T1 - Frequency 3 1.000000 3.000000
o 8 04/13/2005 11:42:20 0 12018 T1 - Frequency 4 1.000000 0.000000
gf“p - ,L 9 04/13/2005 11:42:20 0 12020  T1-Frequency 5 1.000000 0.000000
10 04/13/2005 11:42:20 0 12022 T1 - Frequency 6 1.000000 0.000000
G 11 04/13/2005 11:42:20 (1] 12024 T1 - Frequency 7 1.000000 0.000000
FLOW 12 04/13/2005 11:42:20 0 12026 T1 - Frequency 8 1.000000 0.000000
Archive 13 04/13/2005 11:42:20 0 12028 T1 - Frequency 9 1.000000 0.000000
el 14 04/13/2005 11:42:20 0 12030 T1 - Frequency 10 1.000000 0.000000 ¥
"{f Event Logs
-
EVENT
Archive
MC-III EXP detected - serial no. 16 COmM1 v 1.0.0 4/22/2005 4:05:27 PM

Figure 5.17—Dropdown menu for exporting log data
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Section 6 - MC-Illl WP Maintenance

The MC-III™ WP is designed to provide many years of service with minimal maintenance. Batteries require
periodic replacement, and battery life depends on whether battery power is the primary or secondary power
source.

All configuration settings are stored in nonvolatile memory; therefore, configuration settings will not be lost
in the event of battery failure.

The circuit assembly or keypad may also require replacement over the life of the instrument. Procedures are
provided in this section.

Lithium Battery Replacement

The MC-III WP uses a lithium battery with a life expectancy of approximately 2 years. Due to the flat
discharge characteristics of the lithium battery, it is difficult to determine how much life remains in a battery
at any given time. To preserve configuration and accumulated volume data, replace the battery at 2-year
intervals.

WARNING Do not attempt the replacement of the lithium battery unless the area has been declassi-
f fied or is known to be non-hazardous.
WARNING The lithium battery that powers the MC-lll WP is a sealed unit; however, should a lithium

that the instrument is in a well-ventilated area before opening the enclosure to avoid
breathing fumes trapped inside the enclosure. Exercise caution in handling and dispos-
ing of spent or damaged batteries. See additional information on lithium batteries in
Appendix B of this manual.

f battery develop a leak, toxic fumes could escape upon opening the enclosure. Ensure

Important: Press the ENTER/SAVE key on the keypad before replacing the lithium battery to save
the accumulated total to nonvolatile memory. Once the battery is replaced and power is
restored to the unit, the last saved accumulated total will be displayed in the LCD.

The lithium battery is secured inside the enclosure by a velcro strap and connected to the circuit assembly via
connector J1.

To replace the lithium battery in the MC-III WP, perform the following steps:
1. Open the door of the enclosure to access the lithium battery.

2. Loosen the velcro strap, disconnect the battery from the connector J1 on the circuit assembly, and remove
the battery from the enclosure (Figure 6.1, page 90). Send the depleted battery to a fully permitted Treat-
ment, Storage and Disposal Facility (TSDF) or to a permitted recycling/reclamation facility, as required
by federal regulations (see Appendix B).

3. [Install the new battery in the enclosure in the same position as the original battery, and secure the velcro
strap tightly around the battery.

4. Connect the replacement battery to the J1 connector on the circuit assembly.
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5. Close the door of the enclosure and secure the latches.

Important: The interruption of power to the MC-lll WP will cause the internal clock time to be inaccu-
rate. Reset the time via the interactive software. See Time/Date Synchronization, page 54.

Connector J1 Lithium battery
secured with a velcro strap

=

o.

CAUTION:
USE WIRING RATED

50C MINIMUM *

© - — - e 2 =2 = : .f

Figure 6.1—Lithium battery replacement

Alkaline Battery Replacement

The alkaline battery powered instrument features a battery holder containing three D-size alkaline batteries.
The batteries will require periodic replacement. The dimming of the LCD may be an indicator that battery
power is diminishing, and the batteries should be replaced.

WARNING Do not attempt the replacement of the alkaline batteries unless the area has been declas-

f sified or is known to be non-hazardous.

Important: Press the ENTER/SAVE key on the keypad before replacing the alkaline batteries to save
the accumulated total to nonvolatile memory. Once the batteries are replaced and power
is restored to the unit, the last saved accumulated total will be displayed in the LCD.

The alkaline batteries and battery holder are secured inside the MC-III WP enclosure by a velcro strap and the
battery holder is connected to the circuit assembly via connector J1.

To replace the alkaline batteries, perform the following steps:

1. Open the door of the enclosure to access the alkaline battery holder.

2. Loosen the velcro strap and disconnect the battery holder from connector J1 on the circuit assembly.
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3. Remove the spent batteries from the holder (Figure 6.2) and dispose of them in accordance with local
regulations.

Connector J1 Alkaline battery pack
secured with velcro strap

CAUTION:
USE WIRING RATED |
90C MINIMUM )3

Figure 6.2—Alkaline battery replacement

4. Install three new alkaline batteries in the battery holder, observing polarity, position the holder in the
enclosure so that the batteries rest against the back plate and secure the velcro strap to hold the batteries
tightly in place.

5. Reconnect the battery holder to connector J1 on the circuit assembly.

6. Close the door of the enclosure and secure the latches.

Important: The interruption of power to the MC-lll WP will cause the internal clock time to be inaccu-
rate. Reset the time via the interactive software. See Time/Date Synchronization, page 54.
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Circuit Assembly Replacement

WARNING Do not attempt the replacement of the circuit assembly unless the area has been declas-

f sified or is known to be non-hazardous.

Important: Static electricity can damage a circuit board. Handle new boards only by their edges,

and use proper anti-static techniques (such as wearing anti-static wrist strap or touching
metal to establish an earth ground) prior to handling a board.

Important: If possible, record the accumulated total and all configuration settings before replacing

the circuit board. This information can be recorded by hand or captured by saving a con-
figuration file that can be reloaded into the unit after the circuit board is replaced. (See
Saving and Uploading Configuration Files, page 71.)

To replace the circuit assembly, perform the following steps:

1.
2.
3.

Open the door of the enclosure to access the circuit board mounted inside the door.
Record the locations of all cable connections to the circuit assembly.

Using a small standard blade screwdriver, remove all wiring from terminal blocks TB1, TB2, and TB3,
ensuring that all wiring that is connected to powered circuits is insulated with tape.

Unplug the battery cable from connector J1 on the circuit assembly.

Using a small Phillips screwdriver, remove the three screws from the circuit assembly (Figure 6.3).

Flowmeter cable
Connector J1

Mounting screws
(3, typ.)

| CAUTION:
USE WIRING RATED
90C MINIMUM |

S ——— —

Figure 6.3—Removal of circuit assembly
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s

CAUTION: =
USE WIRING RATED |
90C MINIMUM

Figure 6.4—Keypad ribbon cable connection

6.

10.
11.

12.

Vertically flip the circuit board over to view the opposite side of the board where the LCD is mounted.
The keypad ribbon cable will remain attached to the circuit board (Figure 6.4).

From the LCD side of the circuit assembly, disconnect the keypad ribbon cable from connector J3 as fol-
lows:

a. Qrasp the black clip between a thumb and forefinger (see white arrows in Figure 6.5, page 94).

b. Squeeze both sides of the clip and gently pull to release the clip from the plastic connector that holds
it in place. DO NOT PULL on the ribbon cable. When the black plastic clip is properly disengaged,
the cable will release freely.

Remove the original circuit assembly from the enclosure.

Remove the new circuit assembly from any packaging and connect the ribbon cable of the keypad to con-
nector J3 on the LCD side of the circuit assembly as follows:

a. Insert the end of the ribbon cable into the plastic clip.
b. While holding the ribbon cable in place, press the black plastic clip into the connector until it snaps.
Reconnect the battery cable to connector J1 on the circuit assembly.

Center the circuit assembly over the three standoffs on the inside of the enclosure door and secure with
the three screws removed in step 5.

Reconnect all wiring to terminal blocks TB1, TB2 and TB3.
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‘ /— Keypad ribbon cable

Figure 6.5—To release the ribbon cable from the connector, press in on the side tabs of the connector (white
arrows) and gently pull forward (black arrow).

13. Close the door and secure the latches on the enclosure.

14. Recalibrate the MC-I11 WP.

15. Restore power to the peripheral circuitry.

Keypad Replacement

WARNING Do not attempt the replacement of the keypad unless the area has been declassified or is

f known to be non-hazardous.

The keypad is attached to the circuit board by a ribbon cable that passes from the kepad through a slot in the
door and plugs into the LCD side of the circuit board. A silicone rubber sealant is applied to the slot to prevent
leakage. Replacement of the keypad requires the operator to remove the old keypad and remove the sealant
before installing the new keypad.

To replace the keypad assembly, perform the following steps:

1. Using a small Phillips screwdriver, remove the three screws from the circuit assembly (Figure 6.3, page
92).

2. Vertically flip the circuit board over to view the opposite side of the board where the LCD is mounted.
The keypad ribbon cable will remain attached to the circuit board (Figure 6.5).
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3. From the LCD side of the circuit assembly, disconnect the keypad ribbon cable from connector J3 as fol-
lows:

a. Grasp the black clip between a thumb and forefinger (see white arrows in Figure 6.5, page 94).

b. Squeeze both sides of the clip and gently pull to release the clip from the plastic connector that holds
it in place. DO NOT PULL on the ribbon cable. When the black plastic clip is properly disengaged,
the cable will release freely.

4. With a sharp instument, remove the sealant from the slot in the door to free the ribbon cable and to pro-
vide a clean surface for installing the new keypad.

5. Using a sharp instrument, lift one corner of the keypad and peel it from the front of the enclosure. Discard
the keypad and the attached ribbon cable.

Clean the viewing window with rubbing alcohol and allow it to dry.
Remove the backing paper from the new keypad.

Insert the ribbon cable of the new keypad through the slot in the door of the enclosure.

o o =N

Center the keypad in the viewing window of the door and press it into place. Apply light pressure to the
entire surface of the keypad to ensure proper adhesion.

10. Apply an electronic-grade sealant (Dow Corning 738 electrical sealant or equivalent) to the slot around
the ribbon cable to prevent leakage. Allow it to dry.

Caution: Never use an acetic acid-based adhesive to seal the ribbon cable slot. Gases released by
such products can damage electronics.

11. Connect the keypad ribbon cable to connector J3 on the LCD side of the circuit assembly as follows:
a. Insert the end of the ribbon cable into the plastic clip.
b. While holding the ribbon cable in place, press the black plastic clip into the connector until it snaps.

12. Reconnect the circuit assembly to the standoffs inside the door using the three screws that were removed
from the circuit board in step 1.

13. Close the door and secure the latches on the enclosure.

Firmware Update

WARNING Do not attempt the installation of new firmware unless the area has been declassified or

f is known to be non-hazardous.

Before installing new firmware or moving the instrument to a new site, it is recommended that the user
clear the EEPROM, which will erase all configuration settings and log data. To clear the EEPROM, choose
Options/Program Options from the menu bar, select Advanced from the dropdown options list, and click on
the “Clear EEPROM” button (Figure 6.6, page 96).

Technical assistance is typically required for upgrading firmware. Contact Cameron’s Measurement Systems
Division to arrange for an upgrade.
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WARNING

A

Clicking the “Clear EEPROM?” button will delete all configuration settings and log records
in the MC-IIl WP memory.

.Options T
General Advanced Options

Autorun

Communications EERFR.OM Memory
Downloading
warning: Clearing the device EEPROM will delete all settings and log records,

Clear EEPROM

Advanced Access
Data logging Filename:;

CHMUFLD LOG DATANMC-TINAUTO-LOGEING FILES|DATALOG ]

Automatically log data polls

oK | | Cancel

Figure 6.6—EEPROM clearing and automatic data log option

Spare Parts List

WARNING

A

EXPLOSION HAZARD—SUBSTITUTION OF COMPONENTS AND/OR THE USE OF EQUIP-
MENT IN A MANNER OTHER THAN THAT SPECIFIED BY CAMERON MAY IMPAIR SUIT-
ABILITY FOR CLASS |, DIVISION 2. CAMERON BEARS NO LEGAL RESPONSIBILITY FOR
THE PERFORMANCE OF A PRODUCT THAT HAS BEEN SERVICED OR REPAIRED WITH
PARTS THAT ARE NOT AUTHORIZED BY CAMERON.

DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN SWITCHED OFF OR
AREA IS KNOWN TO BE NON-HAZARDOUS.

DO NOT OPEN EQUIPMENT UNLESS SIGNAL CIRCUITS AND POWER HAVE BEEN
SWITCHED OFF OR AREA IS KNOWN TO BE NON-HAZARDOUS.

BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN TO BE NON-HAZARDOUS.

STATIC HAZARD. DO NOT CLEAN OR RUB ENCLOSURE UNLESS AREA IS KNOWN TO
BE NON-HAZARDOUS.
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Quantity Part Number Description

1 9A-50160002 Circuit Assembly

1 9A-90017003 Cable Assembly, MC Series Totalizers, 2-pin
Molded Connector, Direct-Mount, 28-in.

1 9A-100005117 Cable Assembly, Flowmeter, Remote-Mount,
10-ft, with Weatherproof Adapter

1 9A-100005111 Battery - Lithium, 3.6 V

1 9A-50099003 Battery Holder, with 3 Alkaline “D” Batteries

1 9A-100002605 Desiccant Packet

1 9A-50074001 Assembly, Installation Software CD and CD
Pocket Folder

1 9A-50165009 Manual, User, MC-IIl WP

1 9A-50165010 Manual, Quick-Start, MC-11l WP

2 9A-50006000 Bracket, Direct-Mount, MC-IIl WP

1 9A-99011007 Strap, Battery, Velcro, 5/8 in. x 14.5 in.

1 9A-50166004 Assembly, Switchplate, MC-Ill WP

Optional Parts List

Quantity

Part Number

Description

1

9A-101283116

Converter, RS-485 to RS-232, 9-Pin, with 10-ft
Cable

9A-100025195

Converter, RS-485 to RS-232, 25-Pin

9A-0112-9015T

Converter, RS-485 to RS-232, Serial Port
Powered, DB9 Connector on Both Ends

2296650-01

Converter, RS-485 to USB, with 20-ft Cable

Recommended Magnetic Pickups

Quantity

Part Number

Description

1

2295367-01

Pickup, Magnetic, for use with NuFlo liquid
turbine meters 3/4” or smaller, -67°F to 225°F
(-55°C to 107°C)

9A-100002077

Pickup, Magnetic, for use with NuFlo liquid
turbine meters 7/8” or larger, -67°F to 250°F
(-55°C to 121°C)

9A-100002076

Pickup, Magnetic, for use with NuFlo liquid
turbine meters 7/8” or larger, -67°F to 450°F
(-55°C to 232°C)

9A-100003518

Pickup, Magnetic, for use with NuFlo 2” gas
turbine meters, 0°F to 225°F (-18°C to 107°C)
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Appendix A—Software Program Options

In addition to the standard configuration and flow log menus, the MC-III™ interface software includes a
Program Options menu that allows users to customize the way the software functions, handles log data, and
communicates.

To access the Program Options menu, select Options in the menu bar; Program Options is the last entry in the
dropdown list (Figure A.1).

E¥ MC-11l - <No Well Name>

File ‘iew Help

[& configuration Wizard ~ Shift+Ctriswy
™ Advanced Access Shift+Ctri+R

SYSTEN (5 Moshus Stats ShiftClrls Archive Status
Setup Live Updates on MC-Il Msin Screen O AM Daily Logs 54 unread, 384 max
\f/";; i Boironti ME- Man Soren & }.00 pulses/gal Hourly Logs 767 unread, 768 max
N T e I
com 2 Frocrem Opticns. S Stith=CIEO N IR Events Logs 8 unread, 345 max
Serk Flow Input Sensitivity Low sensitivity
p . Instrument Status
s Gas Volume Correction OFF
Ccssﬂ Supply Voltage ~ 3.61 V
WELLSITE
el 420 mA Output OFF Battery Voltage  3.54 V
Int. Temperature 27.9°C, 82.2 °F
‘4& Pulse Dutput OFF Systemn Clock 08/19/08 03:31:54 PM

TURBINE
Input — -
Flow Readings 3

§ Flow Total 753.4 bbl | g,
o [ AE R
Entry Flow Rate 0.00 bbl/day

Flow Total /
Q: Current Day Total 0.0 bbl AL [ Gugl 1534
t : 3 4
Previous Day Total 0.0 bbl - nnnn
4.20 mA _ILive Updates \ d GU.{}A.’ L w1

2 \L MC-lll EXP Flow Anniyaer
MC-ll detected - serial no. 4294967295 COM1 ¥130 /912008 3:48:50 PM

Figure A.1—Program Options menu location

General Options

The General Options screen allows a user to change the threshold setting used to generate a user prompt for
synchronizing the internal clock with the time displayed on the user’s computer.

The MC-III WP includes a real-time clock for timekeeping and log time stamps, and the internal time and date
is preset at the factory. However, if the factory-set time and date are inaccurate for the user (for example, if
the user is in a different time zone), the program will automatically detect the difference between the device’s
internal time and the date and the time/date displayed on the user’s personal computer and prompt the user to
authorize time and date synchronization.

By default, the MC-III WP prompts a user to synchronize the clock display if the time difference is 60
seconds or more. To change the time difference required to generate a “synchronize” prompt, enter a new
threshold value (seconds) in the General Options screen (Figure A.2, page A-2) and click “OK.”
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Opki 0
" ot General Options

Aukarun
Communications
Daownloading
Advanced

Dewvice clock synchronization threshold 60| cec

oK | | Cancel

Figure A.2—Threshold setting for internal clock synchronization

Autorun Options

When the software connects with the MC-III WP, the Device Autorun Options screen appears, prompting the
user to select any of six actions, including navigating to one of three configuration screens, downloading flow
and event logs, and uploading a configuration file. A checkbox at the bottom of the screen allows the user to
automate the selected function each time the software connects to the instrument.

The Autorun Options screen in the Program Options menu (Figure A.3) allows a user to terminate all autorun
functions, or change the autorun selection.

Program Options

'jIOptions ] "
Sensrdl Autorun Options

‘ ]

Communications
Drovvnloscding
Achvanced

Autorun Options
¢ Launch the Configuration Wizard
o to MC-l Main

*

| Goto Advanced Access
o Dovwenload all logs
 Dowwnload only new logs

! Upload & configuration

|| Always dothe selected action on connection

6,8 | | Cancel

Figure A.3—Menu for changing autorun option selection
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To change an autorun setting —that is, to initiate an autorun action, to terminate an autorun action, or to
change to a different autorun action at the next connection—select Autorun from the Program Options menu
(Figure A.3, page A-2), select the appropriate checkboxes, and click “OK.” Verify that the “Always do...”
checkbox is checked if the selected function is to be automated upon each software connection.

Communications Options

The Communications Options screen (Figure A.4) allows users to customize communication parameters for
optimizing performance, depending on the communication path.

Opti . . .
Bennl Communications Options

Autorun

Commumc.atlons v| Always attempt Express Connect on program start-up
Dowvnloading

Advanced Attempt auto-negotiation of fastest baud rate on device connect

v| Toggle RTS line for RS-485 adapter transmit control

Enable Modbus address support for firmware versions 1.06 - 1.08

Timing Parameters

Presend Delay 0 msec Reset to Defaults

Number of Retries 2
Timeout Period Type Optimal (e Fixed
Timeout Period 5000 msec

Enable auto-negotisted baud rate (9600 baud) Test Now

Current link baud rate: 9600 baud

| OK ’ [ Cancel

Figure A.4—Menu for changing communication parameters

Express Connect Option

By default, the interface software automatically attempts to connect to the instrument when a user clicks on
the desktop application icon. This feature is controlled by the “Always attempt Express Connect on program
startup” checkbox setting in the Communications Option screen (Figure A.4).

When multiple devices are daisy-chained together in a network, the “express connect” function can interfere
with the user’s ability to connect to a specific device. To disable the Express Connect function, deselect the
“Always attempt...” checkbox and click “OK.” The software will now attempt to connect with the instrument
only when the user clicks on the LCD image on the Welcome screen or selects File>Express Connect. For
more information, see Sofiware Connection in Multi-Device Network, page 43.

To cancel the “express connect” function without disabling the autorun option, the user can toggle between
connect/disconnect by clicking in the LCD area of the device on the Welcome screen.
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Auto-Negotiate Option

When connected devices are capable of switching baud rates automatically or when devices are directly
connected to an MC-III WP, a user may configure the MC-III interface to automatically negotiate the fastest
baud rate during device connection. This “negotiated” baud rate does not replace the configured baud rate,
but rather provides a temporary boost of baud rate while the computer is connected to the device for faster
downloads. After the software disconnects, the device reverts to the configured baud rate.

By default, this function is disabled. To enable automatic baud rate negotiation on device connect, check the
“Attempt auto-negotiation....” check box in the Communications Option screen (Figure A.4, page A-3) and
click “OK”. To initiate an immediate search for the fastest baud rate without exiting to the Welcome screen,
check the “Enable auto-negotiated baud rate” checkbox, click the “Test Now” button to the right of the
checkbox, and click “Yes” at the prompt in the Confirm dialog box.

Enable Auto-Negotiated Baud Rate Option

The “Enable auto-negotiated...” checkbox enables usage of the baud rate that has been automatically selected
or “negotiated” by the software, either upon connection with the instrument or when the “Test Now” button
was last clicked. See also Auto-Negotiate Option above.

Request-to-Send (RTS) Line Option

Some RS-485 to RS-232 converter modules require a request-to-send (RTS) line for switching between a
“receive” and “transmit” state. This checkbox allows the software to toggle this line, ensuring that incoming
data will be readily transmitted and that the converter will not stall in a “receive” mode after a period of
inactivity. By default, this option is enabled. To disable the option, deselect the checkbox and click “OK.”

Enable Modbus Address Support for Firmware Versions 1.06 through 1.08

Operators with MC-III units programmed with firmware versions 1.06 through 1.08 must check the checkbox
labeled “Enable Modbus Address Support for Firmware Versions 1.06 through 1.08” to ensure seamless
Modbus communication with their units. Operators using any other firmware version with the MC-III should
leave the checkbox unchecked.

Timing Parameters

Presend Delay

On the Communications Options screen, a user can enter a presend delay (milliseconds) to help ensure a
successful connection between the computer and the MC-III when the instrument is networked with a radio
or other low-speed device. The computer transmits a request to send, which turns the device on, and then waits
the specified length of time before attempting to transmit data. By default, this parameter is set to zero.

Number of Retries

By default, the computer will make two attempts to connect to the MC-III WP before providing an error
message. In situations where timeouts are anticipated—for example, due to a slow-speed computer—the
user can increase the length of time allowed for a connection by inputting a larger number in the Number of
Retries field.

Timeout Period Type

A user can select an “optimal” timeout, which is based on the response time of the MC-III WP to various
requests for data at all baud rates during extensive testing, or a fixed timeout determined by the user. By
default, the “optimal” period type is enabled. When a communication error occurs, the “optimal” timeout
allows the software to respond much faster than the more conservative fixed timeout. The optimal setting
is recommended when the software is connecting directly to the instrument. The fixed timeout type is

A-4



MC-1II™ WP Flow Analyzer Appendix A

recommended when data is being transmitted through a radio or other network device (serial to TCP/IP) and
there are recognizable delays in the communication system.

Timeout Period

When a fixed timeout period type is selected, the user enters the timeout period value (in milliseconds) in the
Timeout Period field. When an “optimal” timeout period type is selected, the user can use this field to enter

a percentage by which the “optimal” timeout period is extended. This extension can be advantageous when
connecting to a slow computer.

Downloading Options

The MC-III WP automatically saves daily flow logs on the contract hour, and hourly flow logs around the
clock. The instrument also automatically saves an event log each time a user change is made. By default, the
logs are saved as .csv files.

The Downloading Options screen allows a user to change the format of the auto-save flow logs and event logs
to Excel (.xls) files. To save the logs in .xls format, check the “XLS-MS Excel File” checkbox (Figure A.5).
Additional checkboxes allow for changes in the appearance of downloaded log data.

Users can also export flow data to a .csv or .xIs file as needed. For complete information, see Exporting Flow
Logs, page 8§3.

Oplions - .
General Downloading Options

Autarun
Communications
Downloading
Advanced

Auto-save log file bype

CSY - Comma-separated values text file

# #L5 - M3 Excel file

Use quote character (") as a delimiter in C5Y file exports
Automatically mark new records as read after downloading

v | Round Flow values to number of decimal places set For Flow Walume Display

| ok | | Cancel

Figure A.5—Menu for changing the auto-save log file format
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Advanced Options

Clear EEPROM

The Clear EEPROM function will erase all configuration settings and log data. This task is typically
performed when updating to a new firmware version or before moving the instrument to a new site. To clear
the memory, click on the “Clear EEPROM” button (Figure A.6).

Technical assistance is typically required for upgrading firmware. Contact Cameron’s Measurement Systems
Division to arrange for an upgrade.

WARNING Clicking the “Clear EEPROM” button will delete all configuration settings and log records

f in the MC-lIl WP memory.

Program Options @

..Options .
Eens Advanced Options

Aukorun
Communications
Dovinloading

EEFRCOM Memorsy

Warning: Clearing the device EEPROM will delete all settings and log records,

Clear EEPROM

Advanced Access
Data logging filename:

CMUFLD LOG DATAVMC-TIIAUTO-LOGGING FILES\DATA.LOG =

Automatically log data polls

| oK | | Cancel

Figure A.6—Menu for clearing EEPROMSs and enabling automatic data logs

Automatic Data Logging

Data retrieved from the MC-III WP while in Advanced access mode can be logged to a file by enabling

the “Automatically log data polls” checkbox on the Advanced Options screen. To specify the filename and
location of the file, click the folder icon on the right of the Data logging filename field. The file will include
values that are retrieved from the instrument when the user clicks the “Get All Data” button or enables “Auto
Polling” on the Advanced Access screen. See also Advanced Access, page 74.
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Appendix B—Lithium Battery Information

Lithium Battery Disposal

Once a lithium battery is removed from a device and/or is destined for disposal, it is classified as solid waste
under EPA guidelines. Depleted lithium batteries are also considered to be hazardous waste because they meet
the definition of Reactivity, as per 40 CFR 261.23(a)(2), (3) and (5). This document describes how the lithium
reacts violently with water, forms potentially explosive mixtures with water, and when exposed to certain pH
conditions, generates toxic cyanide or sulfide gases.

Federal law requires that depleted lithium batteries be sent to a fully permitted Treatment, Storage and
Disposal Facility (TSDF) or to a permitted recycling/reclamation facility.

Important: Do not ship lithium batteries to Cameron. Cameron facilities are not permitted recycling/
reclamation facilities.

Caution: Profiling and waste characterization procedures must be followed prior to shipping a
lithium battery to a disposal site. It is the shipper’s responsibility to comply with all ap-
plicable federal transportation regulations (see below).

Transportation Information

Warning: The MC-IIl WP™ Flow Analyzer contains lithium batteries. The internal component
(thionyl chloride) is hazardous under the criteria of the Federal OHSA Hazard Communi-
cation Standard 29 CFR 1920.1200. Before shipping a lithium battery or equipment con-
taining a lithium battery, verify that the packaging and labeling conforms with the latest
version of all applicable regulations.

The transport of the lithium batteries is regulated by the United Nations, “Model Regulations on Transport of
Dangerous Goods,” (special provisions 188, 230, and 310), latest revision.

Within the US the lithium batteries and cells are subject to shipping requirements under Part 49 of the Code
of Federal Regulations (49 CFR, Parts 171, 172, 173, and 175) of the US Hazardous Materials Regulations
(HMR), latest revision.

Shipping of lithium batteries in aircraft is regulated by the International Civil Aviation Organization (ICAO)
and the International Air Transport Association (IATA) requirements in Special Provisions A45, A88 and A99,
latest revision.

Shipping of lithium batteries on sea is regulated the International Maritime Dangerous Goods (IMDG)
requirements in special provisions 188, 230 and 310, latest revision.

Shipping of lithium batteries on road and rail is regulated by requirements in special provisions 188, 230 and
310, latest revision.

Material Safety Data Sheet

For a link to the current MSDS for the lithium batteries used to power the MC-III WP Flow Analyzer, see the
Cameron website: www.c-a-m.com/flo.
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Appendix C—Communications Protocol

Firmware Version 2.03
Register Table Version 1

Introduction

The communications protocol for the MC-III is in accordance with Modicon, Inc. RTU Mode Modbus® as
described in Modicon Modbus Protocol Reference Guide, PI-MBUS-300 Rev. J, June 1996. All registers are
implemented as 4X or holding registers. Reading of registers is implemented via function code 03H (Read
Holding Registers). Writing to registers is implemented via function code 10H (Preset Multiple Registers).
The instrument provides Enron Modbus® compliant downloads for hourly, daily and event records. For details
on Enron Modbus?®, refer to Specifications and Requirements for an Electronic Flow Measurement Remote
Terminal Unit for Enron Corp., Dec. 5, 1994.

Supported Commands

The Modbus® functions supported by the MC-III are as follows:

Function Code Description

(Hex)

03 Read Holding Registers
05 Preset Boolean

(for Enron event record acknowledgement)

10 Preset Multiple Registers

For the read holding and preset multiple registers, the instrument supports the full 250 bytes of data in a
message. This corresponds to 125 registers in 16-bit holding register size and 62 registers in 32-bit holding
register size.

Data Types

Various data types are implemented in the MC-III. The following table lists the formats and the numbers of
bytes and registers associated with each type.

Data Type Byte Count Register Count
Floating Point (FP) 4 2
Floating Point (FP32) 4 1
Unsigned Word (U16) 2 1
Packed ASCII (PA) 2 1

The Floating Point (FP) type follows the IEEE-754 format and consists of 32 bits contained in two registers.
It is utilized for parameters and values that are not integers. For example, Instantaneous Flow Rate is a
parameter that is a floating-point data type. It can be interpreted by reading two registers, starting with register
17014.
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The Floating Point-32 bit (FP32) data type follows the IEEE-754 format and consists of 32 bits contained in a
single register.

The standard word ordering for multiple register data types, such as floating-point numbers or long integers, is
for the most significant word to appear first in the message. For master devices requiring the least significant
word to appear last, a subset of registers is provided on page C-11.

The Unsigned Word (U16) type is used for 16-bit integers and fits into one register.

The Packed ASCII (PA) type contains two bytes that are two unsigned characters. Generally, multiple Packed
ASCII types are arranged consecutively for implementing strings. For example, the device’s well name is a
string of 10 unsigned characters that is implemented as 5 Packed ASCII registers. Here is an example of a
well name that contains the string, “Test Well 413.”

Register Hexadecimal # ASCII Characters
210 54 65 Te

211 7374 St

212 20 57 <SPACE>W

213 65 6C el

214 6C 20 I<SPACE>

215 34 31 41

216 33 FF 3<UNUSED>

Unused characters at the end of each string will report OxFF hexadecimal.

Registers

Each register has an Access type: read-only or read-write, as described below.

Access Type Description
Read Only (RO) Register can only be read.
Read/Write (R/W) Register can be read and written.

The registers are grouped into Modbus® map blocks based on function. The MC-III contains the following
map functions.

Function Starting Register
System Configuration 1000
Real Time 1200
Input Configuration 2000
Output Configuration 4000

Holding Register (16-bit) 8000 and 17001
Holding Register (32-bit) 7000
Control Registers 70

Wellsite Parameters 200
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Appendix C

Note All registers cited in this document refer to the address of the register that appears in the actual Mod-
bus® message. For example, register 17001 has an address of 0x4268 Hexadecimal in the message.

Note  Two sets of 16-bit holding registers are provided (starting at 17001 and 8000). The “8000” set should
be used with master devices that require the holding registers to be in the range of 40000 to 49999.

System Configuration

Register Register o DEE]

(Decimal)  (Hex) Description Type Access  Default
1000 03E8 Product Code u16 RO 64
1001 03E9 Register Table Version Number u16 RO 1

Firmware Version Number
1002 03E (Version = register value divided by 100) u16 RO
(Example: 100 = Version 1.00)
1003 03EB Manufacture Date (MMYY) u16 RO
1004 03EC Sales Date (MMYY) u16 RO
1005 03ED Serial Number 1 u16 RO
1006 03EE Serial Number 2 u16 RO
Power Mode
1007 03EF 0 = High Power u16 R/W 1
1 = Low Power
Internal System Sample Rate
1008 03F0 Number of seconds to measure temperature u16 R/W 3600
and battery voltage
Slave Address
1009 | O3FT 1 11 65535, not including 252-255 or 64764] ute 1 RW !
Baud Rate
Low Power High Power
0-300 5-9600
1-600 6 - 19200
1010 03F2 21200 7 - 38400 u16 R/W 5
3 -2400 8 - 57600
4 -4800 10 - 115200
5-9600
Bus Delay — mS of delay before transmitting 1
1011 03F3 data u16 R/W (10 ms)
(Delay = register value multiplied by 10 mS)
Bus Timeout — mS of delay before resetting 5
1012 03F4 Modbus® u16 R/W (50 mS)
(Timeout = register value multiplied by 10 mS)
Contract Hour
1013 03F5 [0-23] u16 R/W 8
Lock Code
1014 03F6 [0001-9999] u16 R/W 0

C-3



Appendix C MC-III™ WP Flow Analyzer

System Configuration

Register

Register

(Decimal)  (Hex) Description Access  Default
Lock Code Enable
1015 03F7 0 - Disabled u16 R/W 0
1 - Enabled
LCD Contrast
1016 03F8 [0-31] u1e R/W 6

Product Code (register 1000)
The Product Code is a read-only parameter used for identification. This parameter is set at the factory and it
will always read 0x40 hexadecimal (64 decimal).

Firmware/Register Table Version Numbers (registers 1001, 1002)

The Firmware Version and Register Table Version numbers are unsigned 16-bit integers. These parameters are
set at the factory and are read-only. To determine the firmware version number, read the appropriate register
and divide the value read by 100. The general format for firmware version numbers is A.BC. For example, the
firmware register number is read as 0xA7 hexadecimal. This represents 167 and a firmware version of 1.67.

Manufacture Date/Sales Date (registers 1003, 1004)
These parameters are set at the factory and are read-only. These registers are formatted as MMY'Y. For
example, a value of 0905 represents the date September 2005.

Slave Address (register 1009)

The Modbus® slave address is an unsigned word (U16) data type that has a range of values from 1 to 65535,
not including 252 through 255 or 64764. The slave address is configured from a laptop or via the keypad and
is stored in nonvolatile memory.

All MC-Ill devices will respond to addresses 252 through 255 and 64764, and the
response will always be at a baud rate of 9600 baud. For this reason, addresses 252
through 255 and 64764 are reserved and should never be used.

Important

When the slave address is written, the response message will be at the current address. After the response
message is transmitted, the MC-III will change to the new slave address.

Baud Rate (register 1010)

The baud rate is an unsigned word (U16) data type that sets the data rate on the serial port. When the baud rate
is written, the response message will be at the current baud rate. After the response message is transmitted, the
MC-III will change to the new baud rate.

Real Time
Register Register o DEIE]
(Decimal) (Hex) Description Type Access
Year
1200 04B0 (Real Year = register value plus 2000) u16 RIW
1201 04B1 Month [1-12] u16 R/W
1202 04B2 Day [1-31] u16 R/W
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1203 04B3 Hour [0-23] u16 R/W
1204 04B4 Minute [0-59] u16 R/wW
1205 04B5 Second [0-59] u16 R/wW

This block of registers is used to set the instrument’s internal clock. To set the time, it is recommended that all
registers be written in one message.

The time and date can also be read in the holding register groups as floating-point data.

Register
(Decimal)

Register
(Hex)

Input Configuration

Description

DE£:]
Type

Access Default

Volume Units

3 = Thousandths

4 = Ten Thousandths

Units Units x 1000
0 = No Units 16 = No Units
1 = Gallons 17 = Gallons
2 = Barrels 18 = Barrels
3 = Cubic Meters 19 = Cubic Meters
4 = Cubic Feet 20 = Cubic Feet
2000 07DO0 5 = Liters 21 = Liters u16 R/W 2
Standard Units Std. Units x 1000
32 = No Units 48 = No Units
33 = Gallons 49 = Gallons
34 = Barrels 50 = Barrels
35 = Cubic Meters 51 = Cubic Meters
36 = Cubic Feet 52 = Cubic Feet
37 = Liters 53 = Liters
Volume Decimal Point Location
1 = Tenths
2001 07D1 2 = Hundredths u1e R/W 1
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Input Configuration

Register
(Decimal)

Register Data

(Hex) Description Type Access Default

Rate Volume Units

Units Units x 1000
0 = No Units 16 = No Units
1 = Gallons 17 = Gallons
2 = Barrels 18 = Barrels
3 = Cubic Meters 19 = Cubic Meters
4 = Cubic Feet 20 = Cubic Feet
5 = Liters 21 = Liters
2002 07D2 u1e R/W
Standard Units Std. Units x 1000
32 = No Units 48 = No Units
33 = Gallons 49 = Gallons
34 = Barrels 50 = Barrels
35 = Cubic Meters 51 = Cubic Meters
36 = Cubic Feet 52 = Cubic Feet
37 = Liters 53 = Liters
Rate Time Base
0 = Second
2003 07D3 1 = Minute u1e R/W
2 = Hour
3 = Day
Rate Decimal Point Location
0 = No digits to the right of the decimal point
2004 07D4 1 = Tenths u16 R/W
2 = Hundredths
3 = Thousandths
2005 07D5 Calculation Period U16 RIW
(sec)
Turbine Meter Input Configuration
0 = Pulse Input
2006 07D6 1=TFM - LOW u16 R/W
2=TFM - MED
3=TFM - HIGH
2007 07D7 Low Frequency Cut-Off Threshold U16
(Hz)
Factor Type
1 = 1-Point K-Factor
2008 07D8 2 = 2-Point K-Factor u16 R/W

12 = 12-Point K-Factor
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Register

(Decimal)

Register

(Hex)

Input Configuration

Description

Access Default

Factor Units
0 = No Units
1 = Gallons
2009 07D9 2 = Liters u16 R/W 1
3 = Barrels
4 = Cubic Feet
5 = Cubic Meters
Factor Decimal Point Location
0 = No digits to the right of the decimal point
1 = Tenths
2010 07DA 5 = Hundredths u16 R/W 2
3 = Thousandths
4 = Ten Thousandths
2011 07DB Calibration Frequency [1] (Hz)* FP R/W 1.00
2013 07DD Calibration Frequency [2] (Hz)* FP R/W 1.00
2015 07DF Calibration Frequency [3] (Hz)* FP R/W 1.00
2017 07E1 Calibration Frequency [4] (Hz)* FP R/W 1.00
2019 07E3 Calibration Frequency [5] (Hz)* FP R/W 1.00
2021 07E5 Callibration Frequency [6] (Hz)* FP R/W 1.00
2023 07E7 Calibration Frequency [7] (Hz)* FP R/W 1.00
2025 07E9 Calibration Frequency [8] (Hz)* FP R/W 1.00
2027 07EB Calibration Frequency [9] (Hz)* FP R/W 1.00
2029 07ED Calibration Frequency [10] (Hz)* FP R/W 1.00
2031 07EF Calibration Frequency [11] (Hz)* FP R/W 1.00
2033 07F1 Calibration Frequency [12] (Hz)* FP R/W 1.00
2035 o7Fg | Calibration Factor [1] . FP RW | 900.00
(pulses per configured factor unit)
2037 o7F5 | Galibration Factor [2] . FP RIW 1.00
(pulses per configured factor unit)
2039 o7F7 | Calibration Factor [3] . FP R/W 1.00
(pulses per configured factor unit)
2041 o7Fg | Calibration Factor [4] . FP RIW 1.00
(pulses per configured factor unit)
2043 o7Fg | Calibration Factor [3] . FP R/W 1.00
(pulses per configured factor unit)
2045 o7Fp | Calibration Factor [6] . FP RIW 1.00
(pulses per configured factor unit)
2047 o7pF | Calibration Factor [7]" . FP R/W 1.00
(pulses per configured factor unit)
2049 0goq | Calibration Factor (8] | FP | RW 1.00
(pulses per configured factor unit)
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Input Configuration

SEEEET AR Description Eaid Access Default

Type

(Decimal) (Hex)

Calibration Factor [9]*

2051 0803 (pulses per configured factor unit) FP 1.00

2053 0gp5 | Calibration Factor [10] . FP RIW 1.00
(pulses per configured factor unit)

2055 0807 Calibration Facter [11] _ Ep RIW 1.00
(pulses per configured factor unit)

2057 0809 Calibration Factor [12] Ep RIW 1.00

(pulses per configured factor unit)

2059 080B Standard Measurement Correction Factor Ep RO 1.00
(to be configured by software only)

2061 080D L'ow Flow Rate Qut-Off Threshold . Ep RIW 1.00
(in terms of configured flow rate units)

*Calibration frequencies and calibration factors are associated in pairs—i.e., Calibration Frequency [1] and
Calibration Factor [1]— and must be sorted in ascending order, based on calibration frequency values, prior
to writing the values to the instrument. Therefore, Calibration Frequency [1] should be the smallest of all
calibration frequencies.

Output Configuration
Register Register o Data
(Decimal) (Hex) Description Type Access Default
Pulse Output Source
4000 OFAOQ 0 = Test Mode/Disabled u16 R/W 0
1 = Enabled
Pulse Output Duration 10
4001 OFA1 (time is register value multiplied by 10 ms) U16 RAW (100 mS)
4002 OFA2 Pulse Output Decimal Point Location u16 R/W 2
4003 oFa3 | Pulse Output Scale Factor . FP | RW 1.00
(in terms of configured volume units)
Analog Output Source
4005 OFA5 0 = Test Mode/Disabled u16 R/W 0
1 = Enabled
4006 OFA6 Analog Output Decimal Point Location U16 R/W 2
4007 OFa7 | Analog Output Low Value . FP RIW 0.00
(in terms of configured flow rate units)
4009 OFAg | Analog Output High Value . FP RW | 1700.00
(in terms of configured flow rate units)

Important Two sets of 16-bit holding registers are provided (starting at 17001 and 8000). The “8000”
set displayed in parentheses in the table on page C-9 should be used with master
devices that require the holding registers to be in the range of 40000 to 49999.
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Holding Registers (16-bit Mode)

Register Register -

(Decimal) (Hex) = CLES Ol
17001 4269 Hourly Pointer
(8000) (1F40) | [1 to 768] FP RO
17003 426B Daily Pointer
(8002) (1F42) [1 to 384] FP RO
17005 426D Event Counter
(8004) (1F44) | [1 to 345] FP RO
17007 426F Real Date
(8006) (1F46) | (MM/DD/YY) FP RO
17009 4271 Real Time
(8008) (1F48) | (HH:MM:SS) FP RO
17011 4273 Grand Total Ep RO
(8010) (1F4A) (in terms of configured volume units)
17013 4275 Instantaneous Flow Rate Ep RO
(8012) (1F4C) (in terms of configured flow rate units)
17015 4277 Daily Total Ep RO
(8014) (1F4E) (in terms of configured volume units)
17017 4279 Daily Run Time
(8016) (1F50) (seconds) FP RO
17019 427B Hourly Total Fp RO
(8018) (1F52) (in terms of configured volume units)
17021 427D Hourly Run Time
(8020) (1F54) (seconds) FP RO
17023 427F Polling Total Fp RO
(8022) (1F56) (in terms of configured volume units)
17025 4281 Polling Run Time
(8024) (1F58) | (seconds) FP RO
17027 4283 Previous Day Total Ep RO
(8026) (1F5A) (in terms of configured volume units)
17029 4285 Previous Day Run Time Fp RO
(8028) (1F5C) (seconds)
17031 4287 Previous Hour Total Ep RO
(8030) (1F5E) (in terms of configured volume units)
17033 4289 Previous Hour Run Time Ep RO
(8032) (1F60) (seconds)
17035 428B Previous Polling Total Fp RO
(8034) (1F62) (in terms of configured volume units)
17037 428D Previous Polling Run Time Ep RO
(8036) (1F64) (seconds)
17039 428F Polling Index
(8038) (1F66) [0-65535] FP RO
17041 4291 Internal Temperature
(8040) (1F68) (°C) FP RO
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Holding Registers (16-bit Mode)

Register Register o

(Decimal) (Hex) LR
17043 4293 Supply Voltage
(8042) (1F6A) | (VDC) FP RO
17045 4295 Battery Voltage
(8044) (1F6C) | (vDC) FP RO
17047 4297 Grand Total
(8046) (1F6E) (base unit) FP RO
17049 4299 Instantaneous Flow Rate Ep RO
(8048) (1F70) (base unit)
17051 429B Daily Total
(8050) (1F72) | (base unit) FP RO
17053 429D Daily Run Time
(8052) (1F74) (seconds) FP RO
17055 429F Hourly Total
(8054) (1F76) | (base unit) FP RO
17057 42A1 Hourly Run Time
(8056) (1F78) | (seconds) FP RO
17059 42A3 Polling Total
(8058) (1F7A) (base unit) FP RO
17061 42A5 Polling Run Time
(8060) (1F7C) (seconds) FP RO
17063 42A7 Previous Day
(8062) (1F7E) | (base unit) FP RO
17065 42A9 Previous Day Run Time Ep RO
(8064) (1F80) (seconds)
17067 42AB Previous Hour
(8066) (1F82) | (base unit) FP RO
17069 42AD Previous Hour Run Time Ep RO
(8068) (1F84) (seconds)
17071 42AF Previous Polling Total Ep RO
(8070) (1F86) (base unit)
17073 42B1 Previous Polling Run Time Ep RO
(8072) (1F88) (seconds)
17075 42B3 Polling Index
(8074) (1F8A) [0-65535] FP RO
17077 42B5
(8076) (1F8C) Pulse Output Pulses FP R/W
17079 42B7
(8078) (1F8E) Analog Output Current FP R/W
17081 42B9 Calculated K-Factor Fp RIW
(8080) (1F90) (in terms of configured factor unit)
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Note: The registers below should be used with master devices that require the floating point numbers to
be presented with the least significant word first. Their counterparts with floating point numbers in
reverse word order—registers 17011, 17013, 17027 and 17015—are listed in the previous table.

Holding Registers (16-bit Mode)—Least Significant Word First

Register Register

(Decimal) (Hex) Description

550 206 | CrandTotal | FP RO
(in terms of configured volume units)

552 298 Ipstantaneous F!ow Rate _ Ep RO
(in terms of configured flow rate units)

554 oop | DailyTotal = | FP RO
(in terms of configured volume units)
556 200 Previous Day Total Fp RO

(in terms of configured volume units)

Base Units/Configured Units
The holding register area provides two blocks of registers. The first block is based on the configured units
of measurement. The configured volume units will follow the settings in the Volume Unit register (2000).

The configured rate units will follow the settings in the Rate Volume units (2002) and the Time-Base register
(2003).

For example, if the settings for the volume unit is 2 (BBL), all of the total parameters such as Grand Total
(17011), Daily Total (17015), etc. will be in terms of barrels. The values in these registers will change if the
user changes the units of measurement that appear on the LCD.

The second block is in terms of base units. These register values are independent of the configured volume
units in the Volume Unit, Rate Volume Unit, and Time-Base registers. For base units, the time base is always
measured in seconds, and the volume and rate volume units are measured in gallons. If the standard correction
factor has been enabled, the volume unit is standard gallons. The standard gallon is calculated as the gallon
measurement times the Standard Measurement Correction factor (2059). If the x1000 unit is enabled, the
volume unit is gallons times 1000.

Conversion Factors
For base units, the volume unit and rate volume unit is measured in gallons.To convert gallons to another unit

of measure, use the conversion factors listed in the table below. For example, to convert gallons to barrels,
multiply gallons times 0.02380952381.

To Convert From Gallons To... Multiply By...

No units 1.00000000000
Barrels 0.02380952381
Cubic meters 0.00378541178
Cubic feet 0.13368055556
Liters 3.78541178400
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Polling Registers

The MC-III device stores the volume accumulated since the last polling sequence in a set of polling registers
(17023). In addition, the instrument monitors the number of seconds of flow time in each polling interval
(17025). There is also an index to the number of polls requested (17039).

The polling sequence is started by writing to the Control Register. Writing the Control Register 1 (70) with
a value of 20000 decimal transfers the polling total (17023) and polling run time (17025), to the previous
polling total (17035) and previous polling run time (17037) registers, increments the polling index (17039)
register and resets the polling total and polling run time registers.

Pointer/Daily/Event Pointer (registers 17001 through 17006)

These registers provide an index of the last record that was stored in the log data. These values start at 1 and
increment with each newly created log. When the maximum number of records is reached, the pointer resets
at 1 and starts incrementing again.

Real Date (registers 17007, 17008)

This register is a floating-point representation of the date, formatted as MMDDY'Y. For example, a value of
91005 represents a date of September 10, 2005.

Real Time (registers 17009, 17010)
This register is a floating-point representation of time, formatted as HH:MM:SS. For example, a value of
180205 represents a time of 6:02:05 PM.

Totals

The instrument provides Grand Total (17011), Daily Total (17015), Hourly Total (17019) and a Polling Total
(17023). It also provides Previous Day Total (17027), Previous Hour Total (17031), and Previous Polling
Total (17035). These totals are available in terms of configured units and base units. Refer to Base Units/
Configured Units, page C-11, for details.

Pulse Output Pulses (register 17077)

When the pulse output is enabled (see Pulse Output Source, register 4000), this register indicates the

current number of output pulses to be sent to the output relay, based on the configured duration. In a typical
application, this register will generally indicate a small number, then quickly count down to zero. In a
situation where pulses are being cached, the pulses register will indicate a large value. When the pulse output
is disabled, a user can use this register to write a desired number of pulses to be output, for use in testing end
devices. Users can also perform this output test from the software Pulse Output configuration screen. For
details, see Pulse Output Testing, page 70.

Analog Output Current (register 17079)

When the analog output is enabled (see Analog Output Source, register 4005), this register indicates the
calculated output current based on the low and high values and the instantaneous flow rate. When the analog
output is disabled, a user can use this register to write a desired output current for use in testing end devices.
Users can also perform this output test from the software 4-20 mA Output configuration screen. For details,
see 4-20 mA Output Testing, page 67.

Calculated K-Factor (register 17081)
This register represents the K-factor that was used for the most recent calculation interval. This number
is calculated based on the factor type (register 2008), the instantaneous frequency from the flowmeter,
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calibration frequencies (registers 2011 through 2033), and calibration factors (registers 2035 through 2057).
The unit of measurement for this register is pulses per configured factor unit. Once the K-factor is calculated
based on frequency and K-factor points, this value is multiplied by 1000 if the user chooses to read the
volume in units x 1000, and it is divided by the Standard Measurement Correction Factor (register 2059).

Holding Registers (32-bit Mode)

Setne, "y oo it
7000 1B58 H"t‘é”;’(;?i”ter FP32 RO
7001 1B59 ﬁati(')y;é‘f]”ter FP32 RO
7002 1B5A ﬁ"g”gf%“”ter FP32 RO
7003 1B5B (Rl\m' /BgtﬁY) FP32 RO
7004 1B5C (RF‘TH""'J:{A“ZS) FP32 RO
7005 1gsp | Srand Total FP32 RO

(in terms of configured volume units)

7006 1B5E Ipstantaneous F!ow Rate . FP32 RO
(in terms of configured flow rate units)

7007 1gsF | Daly Total = . FP32 RO
(in terms of configured volume units)

7008 1Beo | Dally Run Time FP32 RO
(seconds)

7009 1Be1 | HouryTotal . FP32 RO
(in terms of configured volume units)

7010 1Be2 | Hourly Run Time FP32 RO
(seconds)

7011 1ge3 | Foling Total . FP32 RO
(in terms of configured volume units)

7012 1Be4 | olling Run Time FP32 RO
(seconds)

7013 1Be5 | -revious Day Total . FP32 RO
(in terms of configured volume units)

7014 1B66 Previous Day Run Time FP32 RO

(seconds)

7015 1Be7 | -revious Hour Total . FP32 RO
(in terms of configured volume units)

7016 1B68 Previous Hour Run Time FP32 RO
(seconds)

Previous Polling Total

7017 1869 (in terms of configured volume units)

FP32 RO

Previous Polling Run Time

7018 1B6A (seconds)

FP32 RO
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Holding Registers (32-bit Mode)

Register Register o Data
) (Hex) Description Type Access

Polling Index

7019 1B6B [0-65535] FP32 RO

7020 1B6C '([‘éf)ma' Temp FP32 RO
Supply Voltage

7021 1B6D (VDC) FP32 RO
Battery Voltage

7022 1B6E (VDC) FP32 RO

7023 1geF | Grand Total FP32 RO
(base unit)

7024 1B70 Instantar!eous Flow Rate FP32 RO
(base unit)

7025 1g71 | Daily Total FP32 RO
(base unit)

7026 1g72 | Daily RunTime FP32 RO
(seconds)

7027 1g73 | Hourly Total FP32 RO
(base unit)

7028 1B74 | Hourly Run Time FP32 RO
(seconds)

7029 1g75 | Folling Total FP32 RO
(base unit)

7030 1g7e | olling Run Time FP32 RO
(seconds)

7031 1g77 | Frevious Day FP32 RO
(base unit)

7032 1B78 Previous Day Run Time FP32 RO
(seconds)

7033 1B7g | Previous Hour FP32 RO
(base unit)

7034 1B7A Previous Hour Run Time Fp32 RO
(seconds)

7035 1B7B Previous.PoIIing Total FP32 RO
(base unit)

7036 1B7C Previous Polling Run Time FP32 RO
(seconds)
Polling Index

7037 1B7D [0-65535] FP32 RO

7038 1B7E Pulse Output Pulses FP32 R/W

7039 1B7F Analog Output Current FP32 R/W

7040 1Bgo | Calculated K-Factor . FP32 RO
(in terms of configured factor unit)
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Appendix C

Register

(Decimal)

Register
(Hex)

Control Register

Description

70

0046

Control Register #1

u16

R/W

The Control register allows specific functions to be implemented via the communication port. The following

table shows the value to be written to the control register to implement the desired function.

Register

Code Function

Transfers the polling total and polling run time
to the previous polling total and previous polling
20000 run time registers, increments the polling index
register, and resets the polling total and polling run
time registers.
30000 Resets grand total
40000 Loads factory defaults
40040 Creates processor reset

Register

Wellsite Parameters

(Decimal| L Hegr | | BesetRten Type
200 00C8 Company Name [20 characters] PA RO
210 00D2 Well Name [20 characters] PA RO
220 00DC Site Location [20 characters] PA RO
300 012C Site ID [20 characters] PA RO
310 0136 Tag Name [10 characters] PA RO
315 013B Legal Description [34 characters] PA RO
400 0190 Sensor Model Number [20 characters] PA RO
410 019A Sensor Serial Number [20 characters] PA RO
420 01A4 Measurement Type [20 characters] PA RO
500 01F4 User Note [64 characters] PA RO

These registers provide access to the ASCII characters that are used in the Wellsite Information screen of the
software. These registers are read-only; if these parameters need to be changed, the user must use the interface

software program.

Log Data

The MC-III provides Enron Modbus® compliant downloads. For detailed instructions on downloading hourly,
daily and event data, refer to Specifications and Requirements for an Electronic Flow Measurement Remote
Terminal Unit for Enron Corp. If an Enron host is not available or is too cumbersome to implement, the Enron
records are individually addressed in another Modbus® map. Contact Cameron technical support for details.
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The following registers are used for hourly, daily and event log registers. Hourly and daily records comprise
five values (registers). See the Hourly/Daily Record Format table. Note that event records are downloaded
one at a time.

Enron Registers

Register Register

(Decimal)  (Hex) Description Data Type Access

Refer to Enron
32 0020 Enron Modbus® Event Log Register Event Record RO
Format

Refer to Enron
700 02BC Enron Modbus® Hourly Log Hourly/Daily RO
Record Format

Refer to Enron
701 02BD Enron Modbus® Daily Log Hourly/Daily RO
Record Format

Hourly Pointer

7000 1B58 [ to 768] FP32 RO
Daily Pointer

7001 1B59 [ to 384] FP32 RO
Event Counter

7002 1B5A [1 to 345] FP32 RO

Enron Hourly/Daily Record Format

Parameter Data Type

(Dl\?lt/?DDYY) FP32
(TILTfMM:SS) FP32
Z-tc));zle units) FP32
Fr!ﬁvn\{lt-)rgpif seconds of flow) FP32
(S\;Jggl)y Voltage Epan
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Appendix C

Enron Event Record Format

Parameter Data Type

Status u16
Address U16
Time

(HH:MM:SS) FP32
Date

(MMDDYY) FP32
As-Found FP32
As-Left FP32

The Event Log status is a 16-bit value used to indicate the reset source in the event log. The following table

indicates the reset status.

Reset Status
Normal 0
Power-On Reset 3
Watch-Dog 8
Software Reset 16
Flash Memory Error 32

Log Capacity

Log Type Capacity

Hourly Logs 768
Daily Logs 384
Event Logs 345
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WARRANTY - LIMITATION OF LIABILITY: Seller warrants only title to the products, soft-
ware, supplies and materials and that, except as to software, the same are free from defects
in workmanship and materials for a period of one (1) year from the date of delivery. Seller
does not warranty that software is free from error or that software will run in an uninterrupted
fashion. Seller provides all software “as is”. THERE ARE NO WARRANTIES, WPRESS
OR IMPLIED, OF MERCHANTABILITY, FITNESS OR OTHERWISE WHICH EXTEND
BEYOND THOSE STATED IN THE IMMEDIATELY PRECEDING SENTENCE. Seller’s li-
ability and Buyer’s exclusive remedy in any case of action (whether in contract, tort, breach
of warranty or otherwise) arising out of the sale or use of any products, software, supplies,
or materials is expressly limited to the replacement of such products, software, supplies,
or materials on their return to Seller or, at Seller’s option, to the allowance to the customer
of credit for the cost of such items. In no event shall Seller be liable for special, incidental,
indirect, punitive or consequential damages. Seller does not warrant in any way products,
software, supplies and materials not manufactured by Seller, and such will be sold only with
the warranties that are given by the manufacturer thereof. Seller will pass only through to
its purchaser of such items the warranty granted to it by the manufacturer.

+  Add intelligent action to your oil & gas solutions + -+

@ Sensia LLC 2021. All rights reserved.
* Mark of Sensia. Other company, product, and service names are the properties of their respective owners.
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